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Census and Survey Mapping», разработанного подразделением Тихоокеанского 

сообщества по статистике для развития в рамках многолетней программы 

индивидуального обучения и внутренних мастер-классов QGIS. Фонд признателен 

за возможность использовать отличную работу за авторством Луи де ла Рюа, 

специалиста по ГИС, под руководством Фила Брайта, ведущего специалиста в 

области инноваций и распространения ГИС. 

Признавая ценность распространения работы, проведенной Тихоокеанском 

регионе, на национальные бюро статистики по всему миру, UNFPA в стремлении 

внести свой вклад в модернизацию систем переписей и обработки 

демографических данных рассмотрела и переработала документ Тихоокеанского 

сообщества для адаптации к мировой практике. В процессе адаптации для 

международного использования в руководство были включены новые темы и 

данные со всего мира. Консультанты UNFPA по вопросам народонаселения и 

развития, главные технические консультанты по переписи населения и 

технические специалисты UNFPA по GRID3 (географическая система данных по 

инфраструктуре и демографии для развития) из всех регионов предоставили свои 
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СПИСОК СОКРАЩЕНИЙ И 
АББРЕВИАТУР 
 
 

CAPI - автоматизированное личное интервью 
CRS - координатная справочная система 
CSV - значения, разделенные запятой 
DB - база данных 
DEM - цифровая модель рельефа 
EA - область учета 
EPSG - Европейская группа нефтепоисковых исследований 
FAO - Продовольственная и сельскохозяйственная организация ООН в США 
GEMET - Главный европейский многоязычный словарь по экологической терминологии 
GIS - географическая информационная система 
GPS - глобальная система позиционирования 
GRID3 - географическая система данных по инфраструктуре и демографии для развития  

HH - домохозяйство 
ISO - Международная организация по стандартизации  

KML - язык разметки Keyhole  

LTR - выпуск с долгосрочной поддержкой 
NASA - Национальная администрация по аэронавтике и космосу  

OSM - Open Street Map  

OTF - «на лету»  

PDF - формат переносимых документов  

SPC - Тихоокеанское сообщество  

SRTM - Радиолокационная топографическая миссия шаттла  

SVG - Масштабируемая векторная графика  

TMS - Сервис тайловых карт  

UNFPA - Фонд народонаселения Организации Объединенных Наций  

URL - унифицированный указатель ресурса  

USB - универсальная шина последовательной передачи данных  

WASH - Вода, санитария и гигиена  

WGS – Мировая геодезическая система 
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1 ОБЗОР И ВВЕДЕНИЕ 
 

1.1. Справочная информация к руководству 
Перепись населения и жилищного фонда относится к наиболее сложным и масштабным мероприятиям, которые та или 

иная страна может провести в мирное время. Она требует составления карты всей страны, мобилизации и подготовки 

большого числа регистраторов, проведения кампании по информированию населения, посещения всех домашних хозяйств, 

сбора огромного объема данных в бумажной или электронной форме, анализа и распространения данных. По определению 

перепись населения и жилья представляет учет общей численности населения страны, который содержит данные о 

численности населения, их пространственном распределении, половозрастной структуре, условиях их жизни и другие 

ключевые социально-экономические характеристики. Такие данные имеют принципиальное значение для планирования 

развития на национальном и региональном уровнях, отслеживания хода выполнения целей в области устойчивого развития 

(ЦУР), распределения программ по развитию инфраструктуры и социальному обеспечению, для планирования выборов и 

анализа рынков. 

Появился широкий спектр технологических решений для сбора, анализа и распространения данных переписей. Эти 

решения варьируют от использования Интернета, ноутбуков, портативных или планшетных компьютеров, 

геоинформационных систем (ГИС), а также систем сканирования и распознавания. Методы картографирования областей 

учета и домашних хозяйств перешли от письменного составления списков к интегративным методам с использованием 

ГИС, глобальной навигационной спутниковой системы и оцифрованных карт. Методы ввода данных изменились: вместо 

ручного набора данных используются технологии сканирования с визуализацией и безбумажным вводом данных 

посредством электронных опросников. Обработка данных переписей теперь проводится с использованием передовых 

аналитических технологий и визуализационных программ, платформ для электронного распространения данных и 

интерактивных интернет-систем распространения и анализа информации. Новые и развивающиеся технологические 

решения для проведения переписей предоставляют широкие возможности для повышения качества, эффективности и 

своевременности проведения переписи. Для извлечения пользы из этих технологических решений национальные бюро 

статистики должны принимать своевременные стратегические решения по внедрению целесообразных систем. 

 

Внедрение новых развивающихся технологий требует активных вложений со стороны национальных бюро статистики и 

международного сообщества специалистов по статистике. Для успешного применения и внедрения этих инновационных 

технологий потребуются гибкость и готовность к переменам. 

Данное руководство «QGIS как инструмент цифровой картографии в переписях и исследованиях» отвечает требованиям 

стран о том, что международное сотрудничество способствует укреплению национального потенциала и признает 

национальную собственность и лидерство в качестве предпосылок для развития в соответствии с принципами, 

оговоренными на Международной конференции по народонаселению и развитию, а также в соответствии с целями 

развития до 2030 года. С принятием целей развития до 2030 года мы договорились расширить поддержку развития 

возможностей для значительного повышения доступности высококачественных, своевременных и надежных данных, с 

разбивкой по доходам, полу, возрасту, расе, этнической принадлежности, миграционному статусу, инвалидности, 

географическому положению и другим характеристикам, относящимся к национальному контексту к 2030 году. 

Данное руководство является результатом глобального сотрудничества между Фондом Организации Объединенных Наций 

в области народонаселения (UNFPA) и Тихоокеанским сообществом (SPC). Это руководство было разработано в целях 

повышения потенциала национальных бюро статистики в области сбора, анализа, распространения и использования 

высококачественных, своевременных, актуальных и дезагрегированных данных переписей и обследований с привязкой к 

географическому положению для информирования, осуществления, мониторинга и оценки устойчивого развития на благо 

общества. Это руководство охватывает все этапы цифрового картографирования, включая составление карты 

домохозяйств в глобальных навигационных спутниковых системах (GNSS), создание административных границ, 

составление карт для руководителей и регистраторов, базовый пространственный анализ и обработку изображений. Кроме 
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того, оно предоставляет национальным бюро статистики альтернативы коммерческому программному обеспечению для 

цифровой картографии в ходе переписей и обследований. 

1.2  Введение в QGIS 
QGIS — это бесплатная геоинформационная система с открытым исходным кодом. Это означает, что для использования 

программного обеспечения не требуется ни лицензии, ни его покупки. 

Почему для данного руководства была выбрана система QGIS? 

• Она бесплатна и имеет открытый исходный код. 

• Она удобна, проста в освоении и имеет множество вспомогательных и внешних ресурсов, например: 

• Документация QGIS: https://docs.qgis.org/3.10/en/docs/ 

• Учебное руководство по QGIS: https://docs.qgis.org/3.10/en/docs/ training_manual/index.html 

• Сообщество пользователей и разработчиков: https://gis.stackexchange.com/?tags=qgis 

• Блоги: http://plugins.qgis.org/planet/ 

• Она легко устанавливается, поскольку установочный файл занимает около 500 МБ, он не требует лицензии или 
подключения к интернету для установки. 

• Система легко настраивается. Для нее существует широкий спектр свободно доступных плагинов (эквивалент 
расширений ArcGIS) и инструментов. 

• Она регулярно обновляется и улучшается. 

• Экосистема QGIS поддерживает взаимодействие с пакетами GDAL/OGR, SAGA, Orfeo, GRASS или R. 

Но основным аргументом в пользу выбора QGIS была открытость исходного кода и поддержка всех функций 

картографирования, включенных в данное руководство, на уровне, не уступающем таковому у коммерческого ПО. 

В данном руководстве из всех версий, доступных на сайте QGIS, пользователю рекомендуется использовать выпуск QGIS с 

долгосрочной поддержкой (LTR) для Windows. Версия LTR была выбрана в пользу новейшему выпуску в силу повышенной 

стабильности и наличия регулярных обновлений в течение года. Пользователю следует учитывать, что в силу 

постепенного улучшения LTR-версии некоторые рабочие процессы могут претерпеть изменения. 

1.3 Практическая структура данного руководства 
Это руководство было задумано как сборник упражнений по выполнению общих задач картографирования, связанных с 

мероприятиями по сбору статистических данных, например переписи и обследования. 

Теоретическая составляющая в уроках была сведена к минимуму, основное внимание было уделено отработке 

необходимых навыков использования данного программного обеспечения. 

Главы состоят из серий упражнений, специально разработанных для закрепления навыков, на которые пользователь будет 

опираться при проведения реальной картографической работы. В этом руководстве систематически разъясняются 

процессы, которым необходимо следовать для выполнения каждой из поставленных задач. Такой подход дает возможность 

пользователю наблюдать заметное развитие собственных навыков, поддерживая мотивацию. 

Для того, чтобы использовать руководство, необходимо загрузить и сохранить сопутствующие учебные материалы. Эти 

материалы разбиты по папкам, соответствующим рабочим процессам в каждой главе руководства. Их можно найти по 

адресу: https://www.spc.int/DigitalLibrary/SDD/Events/QGIS%20manual%20GLOBALmanual%20GLOBAL 

1.4 Условные обозначения в руководстве 

Форматирование текста 

В следующих главах руководства некоторые отрывки текста имеют особое форматирование. Это было сделано для 

выделения различных элементов рабочего процесса и облегчения восприятия материала. В тексте используется 

следующие варианты форматирования: 
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Данный формат обозначает кнопки окон QGIS, а также пути навигации по 

меню QGIS (View > Panels > Browser). 
 

 
Этот формат обозначает меню, панели и окна QGIS, отображаемые в 

интерфейсе. 
 

 
Этот формат обозначает пути хранения файлов и имена слоев, например 

5_polygon_layers/Layers/HH_EAcode_4326.shp 
 

 
Данный формат используется для указания на необходимость ввода 

текста, формул или выражений. 
 

 Данный формат обозначает клавиши.  

 

Использование мыши 

Инструкции по нажатию кнопок мышью были максимально упрощены для облегчения восприятия руководства. Ниже 

приведены описания каждой из функций, использующих мышь как средство ввода: 

СОДЕРЖАНИЕ РУКОВОДСТВА ОПИСАНИЕ 

Щелчок Щелкните левой кнопкой 

Двойной щелчок Двойной щелчок левой кнопкой 

Правый щелчок Щелчок правой кнопкой 

 

Значки в тексте 

В тексте встречаются значки, аналогичные , которые помогают найти органы управления и кнопки в интерфейсе QGIS. 

Панели и числовые последовательности 

В руководстве встречаются изображения меню и панелей QGIS. Эти скриншоты используется для облегчения восприятия 

материала. 

В первых главах скриншоты панелей и окон с заголовками помогут пользователю ориентироваться в элементах 

управления и подразделах различных меню. 

Обратите внимание, что на изображениях меню используются числовые последовательности, в то время как в тексте 

этапы обозначаются буквами. Эти цифры и буквы указывают порядок, в котором будут осуществляться действия; тем не 

менее важно понимать, что между этими двумя порядками может не быть прямого соответствия. В приведенном ниже 

примере действие 1 на картинке не соответствует действию «a» в тексте. 
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Ожидается, что по мере изучения материала пользователь уровень знания ПО пользователем будет повышаться. Таким 

образом, основные процессы будут подробно описаны только в первых главах. Пользователь всегда может вернуться к 

этим главам при возникновении трудностей с последующим материалом. 
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2 УСТАНОВКА ПРОГРАММНОГО 
ОБЕСПЕЧЕНИЯ И ПЕРВЫЕ 
ДЕЙСТВИЯ 

 

Информация в этой главе: 

• инструкции по загрузке и установке LTR-версии QGIS; 

• информация о плагинах, порядок их загрузки, установки и управления в 

приложении QGIS. 

 

 
 

2.1 Загрузка и установка QGIS 3 
В разделе загрузок на сайте QGIS https://www.qgis.org/en/site/forusers/download.html  доступны различные версии QGIS. В 

верхней части страницы приведена информация о последних версиях, доступных для различных платформ. 

Для загрузки доступны как 32-, так и 64-разрядные версии. На 32-разрядные компьютеры и операционные системы 

рекомендуется устанавливать 32-разрядную версию, в то время как на 64-разрядные компьютеры и операционные системы 

можно устанавливать любую версию. Рекомендуется 64-битная версия, так как она позволяет лучше использовать 

системную память. 

Порядок загрузки и установки QGIS на компьютер: 

a. Откройте интернет-браузер и вставьте URL https://www.qgis.org/en/site/forusers/download.html в адресную 

строку. 

b. В разделе пакетов для автономной установки OSGeo4W найдите подраздел версий с долгосрочной 

поддержкой и выберите 32- или 64-разрядный вариант, совместимый с вашим компьютером и операционной 

системой. В нашем случае мы выберем 64-разрядный вариант. Процесс загрузки начнется после нажатия на 

выбранный вариант. 
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c. После загрузки программного обеспечения перейдите в папку загрузки установочного файла и 
дважды щелкните по нему. 

 
 

 
 
 

d. На экране появится следующий диалог. Нажмите кнопку Yes (Да). 

 

 
 
 

e. В диалоговом окне Welcome to the QGIS (Добро пожаловать в QGIS) нажмите кнопку Next (Далее). 
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f. В диалоговом окне License Agreement (Лицензионное соглашение) нажмите кнопку I Agree (Принимаю). 

 

 
 

g.  В диалоговом окне Choose Install Location (Выбор места установки) оставьте путь установки по умолчанию и 

нажмите на кнопку Next (Далее). 

 

 
 

h. В диалоговом окне Choose components (Выбор компонентов) оставьте стандартный набор компонентов и 

нажмите кнопку Install (Установить). 
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i.  После завершения процесса установки нажмите кнопку Finish (Готово). Программное обеспечение 

установлено на ваш компьютер. 

 

 
 
Процесс установки очень прост и не требует подключения к Интернету; он должен занять не более 10 минут. После 

загрузки файла установки достаточно просто следовать вышеописанному порядку действий. 

На рабочем столе будет создана новая папка с именем QGIS 3.10, в которой будут все ярлыки, необходимые для доступа к 

различным программам, включенным в пакет установки. В этом руководстве используется версия QGIS Desktop 3.10 LTR и 

GRASS 7 
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2.2 Плагины: Процесс загрузки и установки 
QGIS имеет множество встроенных функций. Разработчики и пользователи из сообщества QGIS регулярно создают новые 

плагины. Самый простой способ получить к ним доступ — установить их с помощью QGIS Plugin Manager из пакета 

приложений QGIS. Важно отметить, что эти инструменты и расширения абсолютно бесплатны. Это одна из сильных сторон 

QGIS по сравнению с другими ГИС, где для использования некоторых плагинов необходимо приобретать дополнительные 

лицензии. 

 
Как установить новый плагин в QGIS 
a. Откройте программу QGIS. 

b. На верхней панели меню выберите пункт Plugins > Manage and Install Plugins… (Плагины > Управление и 
установка плагинов…)  

c. Нам нужно установить плагин autoSaver, который мы будем использовать далее в этом руководстве. 

d. Убедитесь, что в левой панели выбран вариант All (Все) . 

e. Введите текст autosaver в поле поиска. 

f. Выберите плагин из списка ниже. 

g. Нажмите кнопку Install Plugin (Установить плагин). 

 

 
 
 

Как удалить плагин 

a. В верхнем меню выберите пункт Plugins > Manage and Install Plugins… (Плагины > Управление и установка 

плагинов…) 

b. Перейдите в раздел Installed (Установленные) на левой панели. 

c. Выберите плагин, который вы хотите удалить. 

d. Нажмите кнопку Uninstall Plugin (Удалить плагин). 

e. Обратите внимание, что базовые плагины удалить невозможно, так как они являются неотъемлемой частью ПО. 
 



 QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | УСТАНОВКА ПО И ПЕРВЫЕ ДЕЙСТВИЯ 

 

24 

 
 

Как включить или отключить плагин 
Слишком большое количество плагинов, включенных в приложении QGIS, может приводить к замедлению работы или 

даже к сбою программы. Для обеспечения быстродействия и отзывчивости QGIS очень важно отключать неиспользуемые 

плагины. 
a. В верхнем меню выберите пункт Plugins > Manage and Install Plugins… (Плагины > Управление и установка 
плагинов…). 

b. Выберите раздел Installed (Установленные) на левой стороне окна. 

c. Отметьте галочки напротив плагинов, которые вам нужны в интерфейсе QGIS, или снимите их, если они вам не 

нужны. 

d. Нажмите кнопку Close (Закрыть). 
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2.3 Рекомендуемые плагины 

В этом руководстве приводятся рекомендации по установке, которые полезны для переписей и исследований. Для 

получения более подробной информации о доступных плагинах для QGIS посетите страницу плагинов на сайте QGIS: 

https://plugins.qgis.org/ 

• Digitizing Tools: Этот плагин включает в себя дополнительные инструменты векторного редактирования и 

оцифровки, которые отсутствуют в стандартном меню инструментов QGIS. 

• MMQGIS: Этот плагин добавляет множество дополнительных инструментов для векторного анализа. 

• OSMDownloader: Этот плагин позволяет загружать данные OpenStreetMap (OSM). 

• Point sampling tool: Плагин осуществляет сбор атрибутов из векторных или растровых слоев с помощью слоя 

точек выборки и очень полезен при работе со слоями расположения домохозяйств. 

• QGIS Cloud Plugin: Позволяет обмениваться проектами и картами с помощью онлайн-сервиса http://qgiscloud.com 

• QuickMapServices: Плагин используется для добавления базовых карт, например OSM, Bing Maps или Google 

Maps. 

• SRTM Downloader: Этот плагин позволяет загружать заголовки SRTM с сервера NASA. Обратите внимание, что вы 

должны создать учетную запись Earthdata по адресу https://search.earthdata.nasa.gov, если вам нужен доступ к 

наборам данных NASA. 

• autoSaver: Этот плагин автоматически сохраняет проекты и измененные слои с определенной периодичностью. 

• Подробнее о плагинах для QGIS можно узнать по следующему адресу: 

https://docs.qgis.org/3.4/en/docs/user_manual/plugins/plugins.html 
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3 ПЕРВЫЕ ДЕЙСТВИЯ В QGIS 
 

Информация в этой главе: 
• навигация по экосистеме QGIS; 

• основы интерфейсов проекта и макета; 

• функционирование файлов проекта в окружении QGIS. 

 

3.1 Загрузка векторных слоев 

Есть три способа добавить слой на холст карты. 

1. С помощью Data Source Manager (Менеджер источников данных) 

a. Откройте QGIS и нажмите на кнопку , чтобы открыть новый пустой проект. 

b. Нажмите на кнопку ,  чтобы открыть Data Source Manager. 

c. Выберите пункт Vector (Вектор) в левом боковом меню. 

d. На панели Source (Источник) нажмите на кнопку , чтобы открыть файловый менеджер. 

e. Найдите файл 3_first_steps/Layers/Lilongwe_EA_2018_4326.shp 

f. Нажмите на кнопку ADD (Добавить). 
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2. С помощью QGIS Browser 

Инструмент Browser (Обзор) можно открыть из панели Data Source Manager или на панели QGIS, расположенной в 

интерфейсе. Если панель Browser не отображается по умолчанию, то выберите пункт View > Panels > Browser (Вид > 

Панели > Обзор) в верхнем меню. 

Инструмент Browser позволяет просматривать файловую систему компьютера и управлять файлами GIS в системе QGIS. 
a. Перейдите в инструмент Browser. 

b. В древе папок найдите файл 3_first_steps/Layers/ Lilongwe_EA_2018_4326.shp 
c. Дважды щелкните по файлу или перетащите его на холст. 

3. С помощью Проводника Windows 

Чтобы открыть файл shapefile из Windows Explorer, перейдите в папку 

3_first_steps/ Layers/ и перетащите файл с расширением .shp на холст карты. 

 

 

 

 

 

 

 

 
После выполнения вышеописанных действий файл Lilongwe_EA_2018_4326. 

shp отобразится на панелях Map Canvas и  Layers . 
 
   

ВАЖНО 

Файлы Shapefile требуют трех 

дополнительных файлов, 

чтобы их можно было 

использовать в GIS-

программах. Если эти файлы 

не находятся в одной папке, 

то слой не будет 

отображаться на холсте 

карты. 

Обязательно наличие 

файлов .shp (в нем хранится 

геометрия), .shx (положение 

индекса) и .dbf (стандартная 

база данных с таблицей 

атрибутов). 

Файл.prj не обязательно, но 

его наличие настоятельно 

рекомендуется, так как он 

содержит информацию о 

системе координат. 
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3.2 Установка базового стиля 

a. Чтобы открыть окно Layer Properties (Свойства слоя), перейдите на панель Layers (Слои), щелкните правой кнопкой 

мыши и выберите пункт Properties (Свойства) или дважды щелкните по названию слоя. 

 

 

 
b. На левой стороне меню выберите раздел Symbology (Условные обозначения), где находятся параметры слоя, 

включая заливку и контур. 

с. Вы можете настроить собственный стиль, выбрав цвет заливки и контур, а затем нажав на кнопку OK. 
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d. Кроме того, вы можете выбрать один из доступных стилей. 
 

 
 
 
e. Нажмите кнопку Apply (Применить), чтобы просмотреть результаты. 

f. Нажмите кнопку OK, чтобы задать новый стиль. 
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3.3 Настройка базовых меток 

a. Откройте окно Layer Properties (Свойства слоя). 

b. В левом боковом меню выберите раздел Labels (Метки). 

c. В выпадающем меню выберите пункт Single Labels (Одиночные метки) вместо No Labels (Без меток). 

d. В выпадающем меню Value (Значение) выберите атрибут, который будет использоваться для отображения меток 

на слое. В этом случае мы выбираем пункт EA_CODE, поле, где хранятся код области исследования (EA), 

представляемой полигоном. 
e. Определите параметры форматирования для следующих объектов: 

• Text: параметры, определяющие шрифт, гарнитуру, размер или цвет текста. 

• Formatting: параметры форматирования абзацев и чисел. 

• Buffer: параметры для отрисовки цветного контура вокруг меток для улучшения контрастности и читаемости 
карты. 

• Background: параметры для создания панелей различных размеров и форм под метками. 

• Shadow: параметры отображения тени за метками. 

• Callouts: параметры отрисовки линий, соединяющих точки на карте с соответствующими метками. 

• Placement: параметры размещения меток. 

• Rendering: видимость меток на карте в зависимости от различных факторов, включая масштаб или 

взаимодействие с другими элементами карты. 
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f. Нажмите кнопку Apply (Применить), чтобы просмотреть результаты на карте. Добившись нужного результата, 

нажмите кнопку OK, чтобы сохранить изменения. 
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3.4 Как сохранить или открыть проект 

Сессии QGIS называются проектами. Проекты позволяют хранить слои карт, порядок наложения и символику в специально 

разработанном формате. 

По большому счету, файл проекта QGIS хранит следующую информацию: 

• слои, добавленные на холст 

• свойства слоя, включая обозначения и стили 

• проекция для представления карты 

• степень последнего просмотра 

• печатные макеты 

• элементы печатных макетов и их настройки 

• настройки печатного макета атласа 

• настройки оцифровки 

• связи между таблицами 

• стили проекта по умолчанию 

• настройки плагинов 

• запросы, сохраненные в DB Manager (Менеджер баз данных).  

a. Чтобы сохранить новый проект, нажмите на кнопку  выберите место 

сохранения файла и нажмите кнопку Save. 

b. Чтобы сохранить изменения в открытом проекте, нажмите на кнопку . Мы 

рекомендуем сохранять проект как можно чаще. По умолчанию QGIS не имеет 

функции автоматического сохранения, и при возникновении сбоя вы потеряете 

все несохраненные данные. 

c. Нажмите кнопку , чтобы открыть новый пустой проект. 

d. Чтобы открыть существующий проект, нажмите кнопку , перейдите в 

место хранения проекта (расширение .qgs) и нажмите кнопку Open (Открыть). 

 

 

ВАЖНО 

Слои, загруженные в 
проект, не хранятся в 
файле проекта. Проект 
«запоминает» пути 
хранения слоев и 
загружает их оттуда. Это 
означает, что при 
изменении места 
хранения или удалении 
одного из слоев, при 
следующем открытии 
проекта слой не будет 
добавлен на холст, 
поскольку в проекте не 
будет информации о 
новом местоположении 
слоя. 
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3.5 Добавление базовой карты 

 
3.5.1 QuickMapServices 

a. Установите плагин QuickMapServices (подробнее об установке см. в главе 2.2). 

b. В верхней ленте меню выберите пункт Web > QuickMapServices > Settings > More services (Веб > 

QuickMapServices > Настройки > Дополнительные сервисы) и нажмите на кнопку Get contributed pack 

(Загрузить утвержденный пакет). 
 

 
 

c. Перейдите в раздел Visibility (Видимость), выберите сервисы, которые вам нужны, и нажмите на кнопку Save 

(Сохранить). 

 

 

d. Для загрузки спутникового изображения перейдите в раздел Web > QuickMapServices > Google > Google Satellite. 
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Для улучшения разборчивости карты при использовании спутникового изображения в качестве фона мы рекомендуем 

использовать стили с прозрачной заливкой. 

a. Откройте окно Layer Properties (Свойства слоя) двойным щелчком по имени слоя. 

b. Перейдите в раздел Symbology (Условные обозначения) и нажмите кнопку Simple fill (Простая заливка), чтобы 

изменить настройки стиля полигонов. 

c.  В разделе Fill colour (Цвет заливки) выберите прозрачную заливку. 

d. В разделе Stroke color (Цвет контура) выберите цвет контура полигона, контрастирующий с фоном, чтобы 

улучшить видимость границ. 

e. В разделе Stroke width (Ширина контура) найдите компромисс между уровнем детализации и разборчивостью 

границ полигонов. 
 
 

 
 

f.  Нажмите кнопку Apply (Применить) для просмотра изменений на карте. Добившись нужного результата, нажмите 

кнопку OK, чтобы сохранить изменения. 
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3.5.2 XYZ Tiles (Плитки XYZ) 

Существует два способа подключения XYZ-плиток 

1.  Ручная настройка 

a. На панели Browser щелкните правой кнопкой мыши по пункту XYZ Tiles (Плитки XYZ) и выберите пункт New 

Connection (Новое подключение). 

b. В полеName (Имя), введите имя, которое будет отображаться на панели Browser для данного соединения, 

например Google Satellite. 

c. В файле 3_first_steps/Other/Paths XYZ TILE SERVER.txt вы найдете ссылки на несколько сервисов тайловых карт 

(Tile Map Services, TMS). Скопируйте URL под заголовком Google Satellite (третья ссылка в списке) из текстового 

файла и вставьте ее в поле URL. 

d. Нажмите кнопку Ok. 

e. На панели Browser, в разделе XYZ Tiles, должно появиться соединение Google Satellite . 

f. Включите отображение спутниковой фотографии Google в качестве фона холста, дважды щелкнув по пункту Google 

Satellite. 

g. Настройка скрипта на Python1 

Можно использовать несколько TMS одновременно с помощью скрипта на Python, доступного по адресу 

https://raw.githubusercontent.com/klakar/QGIS_resources/master/collections/Geosupportsystem/python/qgis_basemaps.py 

Скрипт также содержится в учебных материалах по адресу 3_first_steps/Other/Script XYZ TILES.txt. 
Загрузите TMS, выполнив следующие действия: 

a. В верхнем меню выберите пункт Plugins > Python Console (Плагины > Консоль Python). 

b. В окне Python Console (Консоль Python) вставьте скрипт в нижнее поле. 

 
1 Данная глава основана на статье блога open.gis.lab: https://opengislab.com/blog/2018/4/15/add-basemaps-in-qgis-30 
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c. Нажмите кнопку  для выполнения команды. 

 

 
 

d. На панели Browser в разделе XYZ Tiles вы увидите список с множеством сервисов тайловых карт. 
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3.6 Как работать с проекциями в QGIS 

По умолчанию проекты QGIS открываются в системе координат WGS 84 (CRS), которая использует код EPSG 4326. QGIS 

конвертирует данные «на лету» (в предыдущих версиях использовался термин OTF). Это означает, что даже если слои 

используют разные CRS, QGIS попытается отобразить их в одном масштабе. 

Проверка проекции проекта 

a. В нижнем правом углу интерфейса QGIS отображается CRS, используемая проектом. 

b. Нажмите кнопку , чтобы открыть окно Project Properties (Свойства проекта) и перейти в раздел 

CRS. 

c. На этой панели можно выбрать CRS, которая будет использоваться проектом. 

d. Используйте поле поиска, чтобы найти подходящую CRS для вашего проекта. В данном случае планируется найти 

систему «PDC Mercator (Система координат Меркатора)». 

e. Выберите CRS с кодом EPSG:3832. 

f. Нажмите кнопку OK. 
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Проверка проекции слоя 

a. Откройте файл 3_first_steps/Layers/South_Tarawa_EAs2015_4326.shp 

b. Откройте окно Layer Properties (Свойства слоя), чтобы узнать, какая CRS используется слоем (чтобы открыть окно 

Layer Properties, нужно дважды щелкнуть по имени слоя на панели Layers (Слои)). 

c. Перейдите в раздел Information (Информация). В разделе Information from provider (Информация от 

поставщика) содержится информация о CRS, используемой слоем. Нажмите кнопку OK. 

 

 

 
Изменение проекции слоя 

a. Откройте файл 3_first_steps/Layers/KIRJID_4326.shf, соответствующий границам острова Кирибати. 

Вы заметите, что две группы островов отображаются на противоположных сторонах карты. Это связано с тем, что 

Международная линия дат пересекает середину географического положения Кирибати. Стандартная CRS в QGIS, WGS 

84, центрирована по нулевому меридиану, но наша карта должна быть центрирована на меридиане 180°. Чтобы решить 

эту проблему, нужно перепроецировать слой в новую систему CRS. 
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b. На панели Layers (Слои) щелкните правой кнопкой по имени слоя и выберите пункт Export > Save Features As... 

(Экспорт > Сохранить элементы как...) 
 

 
 

c. В разделе Format (Формат) убедитесь, что вы выбрали тип файла ESRI Shapefile. 

d. Нажмите на кнопку рядом с полем File name (Имя файла) ( ), чтобы открыть менеджер файлов, а затем 

выберите имя и место сохранения нового слоя. 

e. Рядом с полем CRS находится кнопка , по нажатию на которую открывается диалог Coordinate Reference 

System Selector (Выбор системы координат). 

f. В поле Filter (Фильтр) введите: 3832 

g.  Выберите пункт CRS WGS 84 / PDC Mercator на одной из нижних панелей и нажмите кнопку OK. 
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h. На панели Save Vector Layer as... (Сохранить векторный слой как...) нажмите на кнопку OK. 

i. Измените проекцию проекта на CRS PDC Mercator EPSG:3832, выполнив действия, приведенные в начале главы. 

j. На холсте карты острова будут отображаться должным образом, так как проекция была центрирована на 

Тихоокеанском регионе. 
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3.7 Первый базовый макет области исследования 

В данном разделе описано создание карты исследования для Лилонгве (Малави) для одной из исследуемых областей 

(например, EA 21053008). Прежде чем начать работу с макетом карты, нужно подготовить ее в пустом проекте. 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку .  

b Загрузите файл 3_first_steps/Layers/Lilongwe_EA_2018_4326.shp 

c. Задайте прозрачный цвет для и белый контур для надписей кодов EA (см. разделы 3.2 и 3.3). 

d. Добавьте фоновое изображение Google Satellite с помощью XYZ Tiles. 

e. Сохраните проект в папке 3_first_steps/ . 

f. После выполнения вышеуказанных действий карта должна выглядеть аналогично изображению ниже. 

 

 
 
3.7.1 Создание нового макета печати 

a.  Чтобы открыть новый макет, нажмите кнопку  или выберите в верхнем меню пункт Project > New Print 

Layout (Проект > Новый печатный макет). 

b.   Введите имя макета, затем нажмите кнопку OK, после чего отобразится интерфейс окна Print Layout 

(Печатный макет). 
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3.7.2 Свойства страницы 

 

a. Щелкните правой кнопкой мыши на пустой странице и выберите пункт Page Properties (Свойства страницы). 

 

 
 

b.  Перейдите на вкладку Item Properties (Свойства элемента), расположенную в меню с правой стороны экрана. 

c. Перейдите в раздел Size (Формат) и выберите A4 из выпадающего списка. 

d. Перейдите в раздел Orientation (Ориентация) и выберите пункт Landscape (Портретная). 

e. В разделе Background (Фон), выберите цвет фона страницы. 

 

 
 
Выполняя действия ниже, не забывайте регулярно сохранять изменения нажатием на кнопку  
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3.7.3 Добавление карты 

a. Для добавления холста с картой нажмите кнопку  

b. Выберите прямоугольную область, где будет отображаться карта. 

c. С помощью кнопки  можно выбрать холст карты (и любой другой элемент на макете) и перетащить или 

изменить его размер. 

d.  Для перемещения (приближения и перетаскивания) содержимого холста, а также для центрирования карты 

используйте кнопку . 

e. На правой стороне окна Print Layout (Печатный макет) находятся различные меню, организованные по 

вкладкам. 

f.  Выделив холст, нажмите кнопку Item Properties (Свойства элемента). В этом меню можно настроить размер, 

масштаб или отображение слоев на карте, и другие параметры. Подробности об этом см. в следующих главах 

руководства. 

g. Если вам нужно скопировать масштаб и расположение карты из главного окна QGIS в печатный макет, перейдите 

на вкладку Item Properties (Свойства элемента) и в разделе Extents (Область и масштаб) нажмите на кнопку 

Set для выбора масштаба и расположения карты. 

h. Если вам нужно скопировать масштаб и расположение карты из главного окна QGIS в печатный макет, перейдите 

в раздел ITEM Properties (Свойства элемента) и нажмите на кнопку  
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3.7.4 Добавление заголовка 

a. Чтобы добавить новый заголовок, нажмите кнопку . 

b. Укажите прямоугольную область, в которой будет находится заголовок. 

c. Откройте вкладку Item Properties (Свойства элемента) и введите нужный вам заголовок в разделе Main Properties 
(Основные свойства). 

 
  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | ПЕРВЫЕ ДЕЙСТВИЯ В QGIS 

43 

 

 
d. На вкладке Appearance (Внешний вид) выберите шрифт, размер, цвет и выравнивание текста. 

3.7.5 Добавление шкалы масштаба 

a. Нажмите кнопку , чтобы добавить шкалу масштаба. 

b. Укажите прямоугольную область, в которой будет находится шкала масштаба. 

c. В меню Item Properties можно настроить параметры отображения шкалы масштаба, включая стиль, единицы 

измерения или количество сегментов. 

 

3.7.6 Добавление изображения 

a. Нажмите кнопку  для добавления изображения. Здесь будет рассмотрен пример добавления логотипа рядом с 

заголовком. 

b. Укажите прямоугольную область, в которой будет находится заголовок. 

c. Перейдите на вкладку Item Properties (Свойства элемента). В разделе Main Properties нажмите на кнопку  

d. Найдите изображение, сохраненное по адресу 3_first_steps/Images/QGIS logo.jpg и нажмите кнопку Open 
(Открыть). 

3.7.7 Добавление указателя северного направления 

a. Нажмите на кнопку  для добавления другого изображения. 

b. Укажите прямоугольную область, в которой будет находится указатель северного направления. 

c. Перейдите на вкладку Item Properties (Свойства элемента). В разделе Search Directories (Папки для поиска)  вы 

увидите SVG-объекты, включая различные модели указателей северного направления. 

d. В разделе SVG Parameters (Параметры SVG) можно настроить заливку и контур объекта. 
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3.7.8 Добавление легенды 

a. Нажмите на кнопку , чтобы добавить легенду. 

b. Укажите прямоугольную область, в которой будет находится легенда. 

c. Перейдите на вкладку Item Properties (Свойства элемента). В разделе Legend Items (Элементы легенды) 
снимите галочку с пункта Auto update (Автоматическое обновление) для ручного управления содержимым 

легенды. Элементы управления под панелью предварительного просмотра станут активными. 

 

d. Чтобы удалить один из элементов, выделите его и нажмите кнопку . 

e. Дважды щелкните по элементу или нажмите кнопку  для изменения текста элемента и повышения его 
читаемости. 
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3.7.9 Экспорт или печать карты 

Добившись нужного оформления макета, который должен выглядеть подобно приведенной выше карте, вы можете ее 

экспортировать. 

 

 
 

a. Для непосредственной печати карты нажмите кнопку  

b. Чтобы экспортировать карту в формате изображения, нажмите  

c. Чтобы экспортировать карту в формате SVG, нажмите  

d. Чтобы экспортировать карту в формате PDF, нажмите  

Чтобы узнать больше о макетах, посетите страницу https://docs.qgis.org/3.4/en/docs/user_manual/print_composer/index.html 
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4  СЛОИ ТОЧЕК:  
РАСПОЛОЖЕНИЕ ДОМАШНИХ 
ХОЗЯЙСТВ 
(БАЗОВЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 

 
4.1 Импорт слоев точек из различных источников 
данных 
 

Рамки статистической выборки обычно строятся на основе переписей населения или сельскохозяйственных переписей. 

Информация о местонахождении районов учета или домохозяйств все чаще составляется в цифровом формате с 

привязкой к географическим координатам. Если в качестве единиц используются области учета, список статистических 

единиц может быть простым в производстве. Создание или обновление цифрового слоя границ областей учета может 

потребовать значительных вложений для учреждений статистики и министерств сельского хозяйства. В случае 

исследований домохозяйств или сельскохозяйственных исследований это позволяет определять области учета на основе 

цифровых карт. Это облегчает определение цифровых рамок выборки и создание слоя точек. 

Слои точек используются главным образом в переписях и исследованиях для составления карт домохозяйств (здесь и 

далее HHs) или таких учреждений, как школы, больницы и т.д. Эти точечные местоположения обычно собираются с 

помощью GPS-устройств, планшетов или смартфонов, давая на выходе файлы различных форматов в зависимости от 

устройства или используемого приложения. 

В этой главе рассматривается порядок загрузки слоя точек, созданного либо с помощью GPS-устройства, либо с помощью 

приложения для CAPI (автоматизированного личного интервью) в QGIS. Вне зависимости от источника файла перед 

началом работы нужно определить следующее: 

• CRS, использованная для сбора данных; 

• единицы измерения и формат, указания местоположения точек, с проверкой читаемости этих параметров системой 
QGIS. Например, при использовании CRS WGS 84, которая используется в GPS, нужно проверить, в каких единицах 

выражаются координаты — в десятичных единицах или в градусах /минутах/секундах. Это поможет избежать ошибок 

при отображении точек. 

 
 

4.1.1 CAPI: Файл данных с разделением запятыми (.csv) 

В данном разделе объясняется порядок импорта и вывода данных GPS из базы данных CAPI. QGIS не поддерживает 

импорт таблиц в формате Excel (расширение .xls или .xlsx). Сначала необходимо сохранить таблицы в формате CSV (MS-

DOS). 

a. Для загрузки таблицы в QGIS в верхнем меню программы выберите пункт Layer > Data Source Manager (Слой > 

Менеджер источников данных) или нажмите на кнопку  

b. На левой стороне меню выберите пункт Delimited Text (Текст с разделителями). 

c. На панели File name (Имя файла) нажмите кнопку , чтобы открыть файловый менеджер.  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

74 

d. Откройте файл 4_point_layers/Tables/MOZ_HHlocations.csv 

e. В разделе File Format (Формат файла), выберите пункт CSV (comma separated values) (значения, разделенные 

запятыми). 

f.  В разделе Geometry Definition (Определение геометрии) выберите вариант Point coordinates (Координаты 

точек) , а также поля, соответствующие координатам широты и долготы для полей X field (поле X) и Y field (поле 

Y) соответственно. Убедитесь, что вы сняли галочку с параметра DMS coordinates (Координаты DMS) , поскольку 

в данном случае координаты измеряются градусами с десятичными долями, а не в градусах, минутах и секундах. 

Для параметра Geometry CRS (CRS геометрии), выберите значение EPSG:4326 - WGS 84. 

g. Нажмите кнопку Add (Добавить), а затем кнопку Close (Закрыть). 
 

 
 
 
Соответствующее облако точек отобразится на холсте карты. Обратите внимание, что этот слой не является обычным: 

QGIS рисует точки «на лету», считывая координаты из таблицы. Это означает, что несмотря на отображение, точки не 

поддаются редактированию, например, невозможно создать дополнительную точку или удалить существующую. Чтобы 

получить возможность редактирования таблицу нужно экспортировать в формате shapefile.  
 

h. На панели Layers (Слои) щелкните правой кнопкой мыши по созданному «слою» и в открывшемся меню 

выберите пункт Export > Save Features As (Экспорт > Сохранить элементы как). 
i. В поле Format (Формат) выберите значение ESRI Shapefile. 

j. Нажмите кнопку  и выберите место хранения файла (рекомендуется путь 4_point_layers/Layers/ ). 
k. Для параметра CRS выберите значение EPSG:4326 - WGS 84. 

l. Нажмите кнопку OK. 
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m. Загрузите фон из Google Maps или Satellite, чтобы убедиться, что точки HH отображаются правильно. 
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4.1.2 Единица GPS (в примере используется Garmin Etrex) (формат .gpx) 
Устройства Garmin моделей Etrex 10/20/30 поддерживают подключение к компьютеру по USB для импорта точек с 

координатами GPS в формате .gpx, который можно непосредственно открыть в QGIS. 

a. Для загрузки файла .gpx в верхнем меню выберите пункт Layer > Data Source Manager (Слой > Менеджер 
источников данных) или нажмите кнопку  

b. В левом боковом меню выберите пункт Vector (Вектор). 

c. На панели File name (Имя файла) нажмите кнопку , чтобы открыть файловый менеджер. 

d. Откройте файл 4_point_layers/Etrex/HHlocations_GPS.gpx 

e. Нажмите кнопку Add (Добавить). 

f. В окне Select Vector Layers to Add... (Выберите векторные слои для добавления...) выберите пункт waypoints 

и нажмите кнопку OK. 

 

 
 
 

g. Закройте окно Data Source Manager. 

h. Если на холсте карты не появится новое облако точек, то на панели Layers (Слои) щелкните правой кнопкой 

мыши по слою HHlocations_GPÎ и выберите в контекстном меню пункт Zoom to Layer (Масштаб по слою). 

i. Загрузите фон Google Satellite, чтобы проверить правильность отображения точек GPS. 
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Обратите внимание, что этот слой, как и в предыдущем примере с файлами .csv, не имеет формата shapefile. Это 

ограничивает возможности по манипуляции слоем в QGIS. 

j.  Для экспорта слоя в формате shapefile выполните действия по экспорту файлов .csv в .shp, и сохраните файл в папке 

LpointJayers/ Layers/ 
 
 

4.2 Редактирование слоев точек 

 
4.2.1 Создание или удаление элементов 

a. Откройте новый проект  и загрузите файл 4_point_layers/Layers/HHFrom_GPS_4326.shp на холст карты. 

b. Откройте спутниковое изображение в качестве фона. Оно будет полезно при редактировании слоя. 

При редактировании слоя рекомендуется сделать его копию и работать с ней, не трогая оригинал. Таким образом, если вы 

допустите ошибку, например, случайно стерли элемент, исходный файл поможет восстановить потерянные данные. 

c. Сделайте копию, экспортировав слой в виде файла в папку 4_point_layers/Layers, и дайте ему название, например 

HHFrom_GPS_4326_EDITED.shp. 

d. Удалите исходный файл shapefile с панели Layers (Слои), открыв контекстное меню правым щелчком и выбрав пункт 

Remove Layer... (Удалить слой) 

e. Выберите файл HHFrom_GPS_4326_EDITED на панели Layers (Слои) и выделите его левым щелчком  , чтобы 

начать редактирование. Некоторые из элементов управления на панели Digitizing Toolbar (Панель оцифровки) 

активируются, а рядом с меткой на панели Layers (Слои) появится значок карандаша. 

 

 
 

В этом случае нам нужно добавить несколько элементов, якобы отсутствующих в наборе GPS-данных 
f.  Выберите удобный масштаб и место для добавления нового элемента. 

g. Нажмите кнопку . Курсор поменяет вид с  на . 

h. Поместите курсор над новым местоположением точки и щелкните левой кнопкой.  
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i.  Заполните хотя бы одно поле на панели Features Attributes (Атрибуты элемента) и нажмите кнопку OK. 

j.  Повторите действия для других точек и нажмите кнопку  для сохранения изменений. 

k.  Для выхода из режима редактирования нажмите кнопку  еще раз.  

4.2.2 Перемещение элементов 
QGIS предусматривает два способа перемещения элементов. Первый способ — использование панели Advanced 
Digitizing Toolbar (Панель расширенной оцифровки). 

a. Щелкните правой кнопкой мыши по верхнему меню и в разделе Toolbars (Панели инструментов) выберите пункт 

Advanced Digitizing Toolbar (Панель расширенной оцифровки). Эта панель инструментов (см. ниже) будет 

встроена в верхнее меню, и все элементы управления будут деактивированы. 

 

 
 

b. Нажмите кнопку , чтобы приступить к редактированию. Некоторые элементы управления панели активируются. 

c. Нажмите кнопку . Курсор примет вид символа . 

d. Щелкните левой кнопкой мыши по точке, которую вы хотели бы изменить, а затем передвиньте курсор на новое 

место и щелкните левой кнопкой мыши второй раз. Точка появится на новом месте. 

e. Нажмите кнопку   , чтобы сохранить изменения.  

Второй метод перемещения точек заключается в использовании Vertex Tool (Инструмент вершин), расположенный на 

панели Digitizing Toolbar (Панель оцифровки). 

a. Нажмите кнопку , и курсор примет вид символа .  
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b.Передвиньте курсор на точку, которую нужно переместить. Курсор примет вид символа .  

c. Щелкните левой кнопкой мыши по точке. Курсор примет вид символа . 

d. Переместите точку в новое положение и щелкните левой кнопкой мыши, чтобы поместить точку.  

e. Нажмите кнопку , чтобы сохранить изменения. 

Эти два метода очень похожи, поскольку они оба используют ту же логику: левый щелчок — перемещение — левый 

щелчок. 

4.2.3 Изменение таблицы атрибутов 

В этом разделе приведено продолжение работы со слоем HHFrom_GPS_4326_ EDITED. 

 

a. Выберите слой на панели Layers (Слои) и откройте окно Attribute Table (Таблица атрибутов) щелчком левой 

кнопки мыши по кнопке  в верхнем меню. 

Кроме того, окно Attribute Table можно открыть правым щелчком по слою на панели Layers и последующим выбором 

пункта Open Attribute Table (Открыть таблицу атрибутов).  

 

 
 
 

Обратите внимание, что окно Attribute Table содержит несколько полей, но все они пусты. Они в этом упражнении не 

нужны, поэтому удалим все поля, кроме Name (Имя). 

b.  Для перехода в режим редактирования нажмите кнопку . Этот элемент управления находится как в главном 

окне QGIS, так и в окне Attribute Table. 
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c.  В окне Attribute Table, нажмите кнопку  в ленте меню у заголовка окна. 
d.  Выберите поля для удаления на панели Delete Fields (Удаление полей) и нажмите кнопку OK. 

 

 
 
 

e. Нажмите кнопку , чтобы сохранить изменения. После выполнения этих действий таблица Attribute Table будет 

содержать только поле Name. 

f.  В режиме редактирования можно также менять содержимое ячеек таблицы Attribute Table. В данном случае мы 

заполним поле Name случайными именами для проверки работы этой таблицы. 

 

 
 
 

g.  Нажмите кнопку  и выберите одну из точек на холсте карты. На экране появится панель Identify Results 

(Результаты идентификации). 
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h.  Перейдите в раздел Actions (Действия). Если вы еще в режиме редактирования, то вам будет доступна функция 

Edit feature form (Редактировать данные элемента) (вне режима редактирования будет доступна только функция 

View feature form (Редактировать данные элемента)). 

 

 
 
i. Нажмите кнопку Edit feature form, заполните поля нужными вам данными и нажмите кнопку OK. Изменения, 

внесенные в окне Edit Feature Form, отобразятся в таблице Attribute Table. Нажмите кнопку  для 

сохранения изменений. 
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j. Вернитесь к таблице Attribute Table. Войдите в режим редактирования, а затем нажмите кнопку  для 

создания нового поля (колонки) в таблице Attribute Table. 
k. В заголовке Name, введите название поля. 

l. В поле Type (Тип), мы укажем тип данных, которые будут храниться в новом поле. 

Whole number (Целое число) подходит для данных вроде размер HH, количество комнат в жилом здании или коды 

анкеты. 

Decimal number (Десятичное число) подходит для данных, где используются числа с запятой, например, доли в 

процентах или другие показатели. 

Text (Текст) подходит для имен или населенности. 

Date и Date & Time (Время, время и дата) подходит для хранения дат собеседования или дат рождения. 

m. Создайте два поля: одно с названием Occupancy (Населенность), а другое будет обозначать количество 

проживающих людей в домохозяйстве и иметь имя HHsize. 

 

n. Заполните строки, используя инструменты Edit Feature Form и Attribute Table, а затем нажмите кнопку  для 

сохранения изменений. 

4.2.4 Слияние атрибутов по местоположению (пространственное слияние) 

Мы добавим информацию в таблицу атрибутов GPS-точек с помощью слоя областей исследования. Информация будет 

перенесена из слоя полигонов на слой точек с помощью пространственной связи. 

a. Откройте новый проект  и загрузите файлы 4_point_layers/Layers/MOZ_ HHlocations_4326.shp и 

4_point_layers/Layers/MOZ_EA_ example_4326.shp на холст карты. 

b. На панели Layers (Слои) поместите слой точек над слоем полигонов, чтобы на карте отображались оба слоя. 

c. В верхнем меню выберите пункт Vector > Data Management Tools > Join Attributes by Location (Вектор > 

Инструменты управления данными > Слияние атрибутов по местоположению). 

d. В поле Input layer (Входной слой) выберите файл MOZ_HHlocations_4326.shp — это слой точек, на который 

будет перенесена информация со слоя полигонов. 
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e. В поле Join layer (Добавляемый слой) выберите файл MOZ_EA_example_4326.shp, который будет служить 

источником данных. 

f. В разделе Geometric predicate (Геометрические условия) выберите условие within (в пределах границ). 

g. В поле Fields to add (Добавляемые поля), нажмите кнопку , выберите нужные вам поля и нажмите кнопку 

OK. 

 

h. В поле Joined layer (Объединенный слой) нажмите кнопку  для выбора нового слоя точек и укажите его 

имя (4_point_layers/Layers/MOZ_HHlocations_ ADDED_DATA_4326.shp, как один из примеров). 

i. Нажмите кнопку Run (Запустить). 
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j. На панели Layers появится новый слой точек под названием Joined layer (Объединенный слой). Проверьте его 

таблицу Attribute Table, чтобы проверить, добавлены ли новые поля из файла MOZ_ EA_example_4326.shp. 
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5 СЛОИ ПОЛИГОНОВ: ОБЛАСТИ 
УЧЕТА 
(БАЗОВЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 

 

5.1 Создайте новый слой полигонов: Оцифровка 
новых элементов 

Для начала нужно подготовить файл проект к выполнению упражнения. 

a. Создайте новый проект  и загрузите файл 5_polygon_layers/Layers/MWI_ HH_EAcode_4326.shp на холст 
карты. 

b. Загрузите спутниковое изображение для фона под слоем точек. Это будет полезно при разграничении областей 
учета (EA). 

Слой местоположения HH содержит поле с кодами EA; он поможет определить границы каждой области исследования. 

c. Из панели Layers (Слои) откройте меню Layer Properties (Свойства слоя) и перейдите в раздел Symbology 
(Условные обозначения). 

d. В первом верхнем выпадающем меню выберите пункт Categorized (По категориям). 

e. Для поля Value (Значение) выберите поле EA_CODE и нажмите кнопку Classify (Классифицировать). Обратите 
внимание, что точки отображаются разными цветами в зависимости от кода EA. 
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f. Нажмите кнопку OK. Карта должна выглядеть примерно так: 

Следующий этап — создание нового слоя, соответствующего границам областей исследования. 

g. Нажмите кнопку , или в верхнем меню выберите пункт Layer > Create Layer > New Shapefile Layer... (Слой > 

Создать слой > Новый слой Shapefile...) 

h. В поле File name (Имя файла) нажмите кнопку , чтобы указать имя и местоположение нового файла 

(например, 5_polygon_layers/Layers/EnumAreas_4326.shp ). 
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i. В поле Geometry type (Тип геометрии) выберите значение Polygon. 

j. В поле CRS выберите пункт EPSG:4326 - WGS 84. 

k. В разделе New Field (Новое поле) мы создадим поле с атрибутами Name (Имя): eaid, Type (Тип): Whole number 

(Целое число), и Length (Длина): 10. Нажмите кнопку Add to Fields List (Добавить в список полей). 

 

 
l.  Нажмите кнопку OK, чтобы добавить слой на панель Layers (Слои) (на карте не будет видно полигонов, потому 

что слой пока еще пуст). 

m. Выберите слой на панели Layers и нажмите кнопку  для перехода в режим редактирования. 

n. Нажмите кнопку  для добавления нового полигона.  

Курсор мыши примет вид значка . Даже при использовании инструмента оцифровки вы можете увеличивать и 

уменьшать масштаб карты с помощью колесика мыши и менять область обзора перемещением мыши при 

нажатой левой кнопке. 

o. Очертите границу области пересечения, щелкая по ее границам. Используйте природные и искусственные 

контуры на карте для очерчивания границ. 
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p. Щелкните правой кнопкой мыши для завершения рисования полигона. Появится диалоговое окно Feature 

Attributes (Атрибуты элемента). Заполните поля соответствующей информацией и нажмите кнопку OK. 

 

q. Нарисуйте другие полигоны по областям исследования, следуя вышеописанной процедуре. Как можно чаще 

сохраняйте изменения слоя щелчком по . 

5.2 Прилипание 

Инструмент прилипания позволяет совмещать границы объектов во время оцифровки. Это экономит время и снижает 

вероятность возникновения ошибок (зазоры и перекрывающиеся области полигонов). 

Следующий этап — очистка топологии созданного слоя. Учитывая, что прилипание при создании первых полигонов не 

использовалось, их границы не совпадают друг с другом; в результате слой будет похож на изображение ниже. 
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a. Если панель Snapping Toolbar (Панель инструмента прилипания) недоступна в верхнем меню, то щелкните правой 

кнопкой мыши по верхней ленте меню и выберите пункт Snapping Toolbar в подменю Toolbars (Панели 
инструментов). 

 

 

b. Нажмите кнопку  для включения или выключения инструмента прилипания. 

c. Нажмите кнопку  для выбора слоев, для которых будет включен инструмент прилипания: All Layers (Все слои), 

Active Layer (Активный слой) или Advanced Configuration (Расширенная конфигурация). Выберите вариант 

Active Layer — это самый простой вариант, который поможет научиться использовать инструмент. 

d. Нажмите кнопку  для выбора объектов, к которым будет применяться прилипание: Vertex (Вершина), Segment 

(Сегмент) или Vertex and Segment (Вершина и сегмент). Выберите третий вариант, то есть Vertex and Segment. 

e. С помощью этого меню  можно настроить параметр Tolerance (Допуск) инструмента 

прилипания. Настройка допуска выполняется в единицах карты или в пикселях. Поэкспериментируйте, чтобы 

определить наилучшее значение параметра. 

f. Нажмите кнопку , чтобы включить инструмент Topological Editing (Редактирование топологии) (при 

перемещении вершины с помощью этого инструмента границы элементов с общей вершиной будут меняться 

одновременно). Это очень полезно для разграничения и изменения границ между полигонами EA. 
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g. Нажмите кнопку , чтобы включить или выключить функцию Snapping on Intersection (Прилипание на 

пересечении). Это функция прилипания вершин одного полигона к границам другого, даже если у них нет общей 

вершины. 

5.3 Редактирование (разграничение, атрибуты) 

Включив инструмент прилипания, можно приступать к очистке и улучшению существующих полигонов, чтобы соседние 

полигоны имели четкие границы без пробелов и перекрывающихся областей. 

a. Из панели Layers вызовите меню Layer Properties (Свойства слоя) и выберите пункт Symbology (Условные 

обозначения). Выделите пункт Simple fill (Простая заливка). 

b. Уменьшите значение параметра Opacity (Непрозрачность) до 50%, чтобы под полигоном было видно спутниковое 

изображение, и выберите контрастный цвет для параметра Stroke (Контур). Возможность четко видеть границы 

полигонов очень помогает при исправлении ошибок. 
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c. На панели Layers выберите слой EnumAreas_4326.shp и войдите в режим редактирования . 

d. Нажмите кнопку  для включения инструмента Vertex Tool (Инструмент вершин). Вы заметите, что контур 

полигонов окрашивается красным цветом, если над ними находится курсор. 

e. Перемещение вершины: Выберите вершину, щелкнув по ней левой кнопкой мыши. Переместите курсор к другой 

вершине или линии: вершина прилипнет к этому элементу. Щелкните левой кнопкой еще раз, чтобы подтвердить 

перемещение вершины. 
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f. Создание новой вершины: При наведении курсора на границу полигона в центре сегмента появится 

предполагаемый узел. Щелкните по нему, чтобы привязать его к новому положению. 

 

 

g. Удаление вершины: Выберите вершину, щелкнув по ней при нажатой клавише Shift, или выделив его мышью с 

помощью рамки выделения. Цвет выбранной вершины сменится на синий. Для удаления выбранных вершин нажмите 

клавишу Delete. 

h. Блокировка элемента перед редактированием: В программе предусмотрена функция блокировки элемента 

щелчком правой кнопки мыши. После блокировки все операции по редактированию будут применяться только к 

выбранному полигону. Это очень полезно при редактировании нескольких слоев, находящихся близко друг к другу. В 

такой ситуации работа с сегментами и вершинами может быть сложной, потребуется использовать мышь и функцию 

масштабирования для точного выбора конкретной вершины. 

Займемся перетаскиванием / созданием / удалением вершин для «сшивания» границ между полигонами EA. Используйте 

спутниковое изображение, чтобы лучше определять границы с помощью дорог, улиц и природных контуров там, где это 

возможно. 

I. Не забывайте сохранять правки слоя, нажимая кнопку   
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5.4 Слияние и разделение областей исследования: 
Лучшие методы (система кодов, разграничение) 

В этом упражнении мы проанализируем области исследования и вычислим количество HH, находящихся в пределах 

каждого полигона. Затем мы обновим слой путем разделения и слияния полигонов для выполнения условия «не более 

120 ... 150 HH для каждой области исследования». 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку  

b. Загрузите слои 5_polygon_layers/Layers/HH_NOcode_4326.shp и MWI_ Lilongwe_EA_4326.shp. 

c. Загрузите спутниковое изображение для фона. 

Для подсчета количества HH в каждой EA (количество точек в пределах каждого полигона) мы будем использовать 

инструмент Count Points in Polygon (Подсчет точек в полигоне). 

d. В верхнем меню выберите пункт Vector > Analysis Tools > Count Points in Polygon (Вектор > Инструменты анализа > 

Подсчет точек в полигоне). 

e. В разделе Polygons (Полигоны) выберите файл MWI_Lilongwe_EA_4326.shp 

f. В разделе Points (Точки) выберите файл HH_NOcode_4326.shp 

g. В поле Count field name (Имя поля подсчета) введите текст HHnum 

h. Оставьте раздел Count (Количество) пустым; инструмент создаст временный слой, которого в данный момент 

достаточно. 

i. Нажмите кнопку Run (Запустить), и по завершению процесса нажмите кнопку Close (Закрыть). 

  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

94 

 

 

j. Вы увидите слой Count (Количество) на панели Layers (Слои). Откройте окно Attribute Table  (Таблица 

атрибутов) для этого слоя и убедитесь, что в ней присутствует поле HHnum. 

Поле HHnum позволяет оценить, какие полигоны областей исследования следует изменить для выполнения требований 

по количеству домохозяйств в области. Области исследования, содержащие более 150 HH, следует разделить на более 

мелкие области, в то время как EA с количеством домохозяйств менее 120, следует объединить с другими прилегающими 

полигонами. 

Кроме того, необходимо создать новое поле для хранения новых кодов областей исследования для обновленной карты 

исследования. Вместо создания кодов заново мы добавим цифры к существующим для указания разделения (при 

разделении одной EA более чем на 10 частей мы должны будем добавить две цифры). Например, после разделения EA 

21048001 две получившиеся EA будут иметь коды 210480011 и 21048001 соответственно. Если разделение EA 21055010 

не нужно, то она останется с прежним кодом 210550101. 

a. Для слоя Count откройте таблицу Attribute Table  и откройте Field Calculator (Калькулятор поля), нажав 

кнопку . 

b. Отметьте параметр Create a new field (Создание нового поля).  

c. В поле Output field name (Имя выходного поля), введите EA_2020 

d.  В меню Output field type (Тип выходного поля), выберите пункт Whole number (integer) (Целое число). 

e. В поле Output field length (Длина выходного поля) введите 10 

f. в поле Expression (Выражение) введите текст "EA_CODE" || '1' 

g.  Взгляните на Output preview (Предпросмотр результата), и убедитесь, что результат отображается правильно. 
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h. Нажмите кнопку OK и проверьте таблицу атрибутов, чтобы убедиться, что поле было сгенерировано правильно. 

i. На панели Layers (Слои) щелкните правой кнопкой мыши по слою Count, выберите в меню пункт Export > Save 
Features As... (Экспорт > Сохранить элементы как...) и сохраните его под именем и по адресу 
5_polygon_layers/Layers/ MWI_Lilongwe_EA_2020_4326.shp 

Все элементы для процесса обновления готовы. С этого момента все правки (разделение, слияние и переопределение 

кодов) будут применяться к файлу MWI_Lilongwe_EA_2020_4326.shp 

j. Для защиты слоя MWI_Lilongwe_ EA_4326.shpот нежелательных изменений нужно удалить его из списка Layers 

щелчком правой кнопки мыши по соответствующему слою и выбором в меню пункта Remove Layer (Удалить 

слой). Не забывайте как можно чаще сохранять проект, нажимая кнопку . 

Разделение полигонов EA 

a. Задайте стиль слоя, выбрав прозрачную заливку, чтобы слой спутникового изображения просматривался за слоем 

полигонов. 

b. Перейдите в режим редактирования  для слоя MWI_Lilongwe_EA_2020_4326.shp  

c. Откройте таблицу Attribute Table   и отсортируйте строки по полю HHnum щелчком по заголовку поля. 

Выберите EA с количеством HH более 150 (например, EA210550331 с 301 домохозяйством) и нажмите кнопку  для 

увеличения масштаба выбранного полигона. Этот полигон на холсте карты будет выделен желтым цветом.  

d. Для разделения полигонов нужно нажать на кнопку  для выбора полигонов, и кнопку   для снятия выбора. 

Помните, что перед началом выбора элементов на слое нужно выбрать соответствующий слой на панели Layers 

(Слои).  

Например, полигон EA 210550331 нужно будет разделить на две части, чтобы количество домохозяйств в его границах 

соответствовало требованиям (120-150 HH на одну область). В то же самое время нужно помнить, что границы этих 

областей должны легко определяться по месту нахождения. 

e. Выберите слой IH_NOcode_4326.sh| на панели Layers и выберите инструмент Select Features by Polygon (Выбор 

элементов полигоном) (щелкните по стрелке рядом с кнопкой  для вызова выпадающего меню и нажмите кнопку 

).  
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f. Разграничьте полигон, последовательно щелкая левой кнопкой мыши для выбора точек, которые будут отделены от 

основного полигона. Затем щелкните правой кнопкой мыши для завершения процесса выбора. 
 

 

 

g. Выбранные точки будут выделены желтым цветом. В нижней части интерфейса появится сообщение с указанием 

количества выбранных точек. Мы выбрали 149 точек с четкими границами для нашего нового полигона; это значит, что 

мы можем приступить к процессу разделения полигона. 
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h. Выберите слой MWI_Lilongwe_EA_2020_4326.shp, убедитесь, что вы перешли в режим редактирования , и 

нажмите кнопку Split Features (Отделить элементы) , расположенную на панели Advanced Digitizing Toolbar 

(Панель расширенной оцифровки). Нарисуйте линию, которая разделит полигон надвое, последовательно щелкая 

левой кнопкой мыши. Щелкните правой кнопкой мыши, чтобы завершить рисование новой границы. При создании новой 

границы убедитесь, что начальная и конечная точки линии выходят за границы разделяемого полигона. 
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i. После разделения области исследования на два участка нужно перепроверить количество точек, содержащихся внутри 

новых EA. Выберите слой с точками на панели Layers, выберите инструмент  и щелкните правой кнопкой мыши по 

новому полигону. Выберите полигон MWI_Lilongwe_EA_2020_4326.shp в появившемся диалоговом окне. Произойдет 

автоматический выбор всех точек в пределах полигона. Проверьте количество точек в сообщении в нижней части 

интерфейса. 
 

 
 
 

j. Разделив полигон, вы увидите две одинаковых строки в таблице атрибутов слоя. Следовательно, нам нужно 

назначить другой код EA новому полигону. Выберите новый полигон с помощью  и найдите строку, 

соответствующую полигону, выделенному синим цветом в таблице Attribute Table. Присвойте новый код полю 

EA_2020 (2150550332). 

k. Нажмите кнопку  для применения изменений. 

Повторите процесс для всех областей с количеством домохозяйств более 150. 

Слияние полигонов 

Области исследования со слишком малым количеством 

домохозяйств можно объединить с другими EA для соблюдения 

требований к выборке или для повышения эффективности полевой 

работы. 

a. Откройте таблицу Attribute Table  и отсортируйте строки 

по полю HHnum щелчком по заголовку поля. Выберите одну из 

областей с количеством домохозяйств менее 40. 

Мы воспользуемся метками, которые упростят идентификацию 

областей, подлежащих слиянию, и для указания возможности 

слияния с соседними областями. 

 

ВАЖНО 

Объединить можно 

только те области, 

которые находятся 

на территории 

одной деревни, 

района или округа. 

Соблюдение этого 

правила позволяет 

сохранить иерархию 

административных 

уровней. 
  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

99 

b. Выберите слой MWI_Lilongwe_EA_2020_4326.shp, откройте панель Layer Properties (Свойства слоя) и перейдите в 

раздел Labels (Метки). 

c. Выберите вариант Single labels (Одиночные метки) в первом выпадающем меню. 

d. В меню Value (Значение) нажмите кнопку , чтобы открыть окно Expression Dialog (Диалоговое окно 

выражений) и введите следующее выражение в пустое поле: "TA_CODE" || '-' || "HHnum" 

e. Это выражение создает метку, объединяющую в себе код деревни и количество домохозяйств. 

f.  Альтернативный метод — использовать инструмент Identify features (Определить элементы)  и проверить 

сведения о каждом полигоне один за другим. 

g. Проверьте сообщение Output preview (Предпросмотр результата) на предмет ошибок выражения и нажмите кнопку 

OK. 
 
 

 
 

Задайте оформление для метки на карте (разборчивый шрифт и контрастный цвет) и нажмите кнопку OK. 
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С помощью этих меток, отображаемых на карте, мы можем легко определить, какие области следует объединить, и какие 

из них принадлежат к одной деревне (два полигона EA принадлежат к одной деревне, если первые пять цифр их кодов EA 

совпадают). 

a. Убедитесь, что вы вошли в режим редактирования  

b. Нажмите кнопку  и выберите несколько EA для объединения щелчком левой кнопки мыши при нажатой клавише 

Shift. 

c. Выберите инструмент Merge Selected Features (Объединить выбранные элементы)  

d. На экране появится панель Merge Features Attributes (Атрибуты объединяемых элементов). На этой панели 
можно выбрать значения, которые сохранятся для объединенного полигона 

e. В данном случае мы выберем одну из строк и нажмем кнопку Take attributes from selected feature (Использовать 
атрибуты выбранного элемента). 

f. Другой вариант — заполнить поля строки с заголовком Merge с помощью параметров в выпадающих меню верхней 
строки. В данном случае мы сложим количество HH с помощью параметра Sum в поле HHnum.  

 

 
 
Завершив работу с полями, нажмите кнопку OK для завершения процесса слияния. 
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5.5  Стили слоев 

 

5.5.1  Подходящие обозначения при отображении административных границ 

При отображении административных границ необходимо определить некоторые правила оформления, чтобы карты были 

легко читаемыми. При загрузке слоя с полигоном на холст карты QGIS по умолчанию применяет к ним случайное 

оформление, которое в большинстве случаев не подходит для работы. 

Если вы планируете работать со слоем в течение долгого времени или если он будет включен в карту, то необходимо 

определить приоритеты соответствующих обозначений. 

Заливка: Мы рекомендуем использовать бледные пастельные цвета, избегая ярких и темных цветов. Если вы планируете 

использовать спутниковое изображение в качестве фона, вам нужно будет настроить прозрачность полигональных слоев, 

чтобы этот фон можно было разглядеть за полигонами. 

Граница / контур: Мы рекомендуем использовать цвета, которые контрастируют с цветом заливки, чтобы лучше 

различать границы полигонов. Вы можете менять толщину линии для улучшения отображения границ, но помните, что чем 

толще линия, тем меньше деталей границы вы увидите на карте. 
Метки: Используйте простые шрифты с легко читаемым размером (не менее 6-7 точек для печатных карт). Настраивайте 

цвет, контур и фон шрифта для улучшения читаемости метки, если они располагаются на темном фоне. 

5.5.2  Управление стилями слоев 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите слои 5_polygon_layers/Layers/HH_EAcode_4326.shp и 5_ polygon_layers/Layers/MWI_EA_Pop_4326.sh| . 
c. Загрузите спутниковое изображение для фона. 

Мы настроим два стиля: один для карты с фоном спутникового изображения, другой для карты без него. Метки полигонов 

EA будут содержать код области, а метки точек будут содержать идентификатор HHid. 

d. На панели Layers (Слои) щелкните правой кнопкой мыши по слою HH_EAcode_4326.shp и выберите пункт Zoom to 

Layer (Приблизить к слою). 

e. Создайте копии обоих слоев в проекте, щелкнув правой кнопкой мыши по слою на панели Layers и выбрав пункт 

Duplicate Layer (Создать копию слоя). 

f. Переименуйте оба слоя вызовом контекстного меню слоя и выбором пункта Rename Layer (Переименовать слой) 

или нажатием клавиши F2. 
 

 

g. Для карты со спутниковым изображением в качестве фона желательно выбрать стиль с прозрачной или 

полупрозрачной заливкой и контрастными границами, чтобы фоновое изображение легко просматривалось. Стиль 

карты без фона может быть проще, но в то же время желательно подобрать цвет, который повышает читаемость 

карты.  
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h. Чтобы сохранить стиль для других карт и проектов перейдите на панель Layer Properties (Свойства слоя), 
перейдите в раздел Symbology (Условные обозначения), нажмите кнопку Save Symbol (Сохранить обозначения) 
и введите название стиля (например, EA transparent). Отметьте пункт Add to favorites (Добавить в избранное), 
затем нажмите кнопку Save (Сохранить), а затем кнопку OK. В следующий раз при вызове меню условных 

обозначений стиль EA transparent будет доступен в разделе Favorites (Избранное) на панели стилей. 

 

 

i. Формат слоя можно скопировать с помощью инструмента Copy/Paste styles (Копировать / вставить стили). Щелкните 

правой кнопкой мыши по слою на панели Layers и выберите пункт Styles > Copy Style > All Style Categories (Стили 

> Копировать стиль > Все категории стилей). 
j. Выберите слой с другим полигоном и выберите пункт Styles > Paste Style > All Style Categories (Стили > Вставить 

стиль > Все категории стилей). При выборе пункта All Style Categories (Все категории стилей) вы перенесете все 
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настройки параметров исходного слоя. Чтобы перенести только одну из категорий, выберите соответствующую 

категорию в меню и примените ее к другому слою. 

 
 
5.5.3  Темы слоев 

Инструмент Themes (Темы)  расположен в верхней части панели Layers (Слои) и позволяет создавать темы 

оформления для: 

•  контроля видимости слоев на холсте карты; 
•  использовать стиль каждого слоя, включенного в тему; 

•  применять некоторые параметры конфигурации легенды в интерфейсе Print Layout (Печатный макет). 

Этот инструмент очень полезен при наличии различных макетов и карт, созданных в одном проекте. Это позволяет нам 

переключаться с одной карты на другую без включения / выключения каждого слоя по отдельности. 

В данном примере примере мы настроим две темы: одна тема для карты со спутниковым фоном и другая для карты без 

фона. 

a. На панели Layers (Слои) выберите слой со спутниковым изображением для фона. Стиль слоя уже настроен в 

предыдущем разделе.  
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b. Нажмите кнопку и выберите вариант Add Theme (Добавить тему). 

c. Введите имя новой темы (например, Background) и нажмите кнопку OK. 

d. Открыв меню Themes (Темы), вы увидите созданную тему в списке доступных. 
 

 

 
 
 

e. Создайте тему для слоев без спутникового фона (не забудьте отключить спутниковый слой) и попробуйте 

переключиться с одной темы на другую в интерфейсе карты. 
5.5.4  Стили по категориям, с градуировкой и правилами 

Обозначения по категориям 

a. Загрузите слой 5_polygon_layers/Layers/MWI_EA_Pop_4326.shp на холст карты. 

b. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения). 

c. В верхнем выпадающем меню выберите пункт Categorized (По категориям). 

d. В меню Value (Значение), выберите поле, которое будет использоваться для создания различных категорий. В 

данном примере нам нужно отобразить различные районы на карте, поэтому следует выбрать или код района 
(DIST_CODE), или имя района (DIST_NAME). 

e. Нажмите кнопку Classify (Классификация), и на верхней панели отобразятся все доступные категории. Отметьте все 

деревни, которые вам нужно отобразить на карте. Двойным щелчком по символу вызовите панель Symbol Selector 
(Выбор обозначений), что позволит вам менять цвет каждой категории по отдельности.  
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f.  После завершения настройки обозначений нажмите кнопку OK.  

Обозначения с градуировкой 

Обозначения с градуировкой полезны для составления хороплетов (фоновых карт, где области окрашиваются по шкале 

определенного показателя). Для построения фоновой карты переменная обязательно должна быть приведена к 

стандартной шкале. Наиболее распространенные способы стандартизации данных — деление показателя на площадь или 
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на количество элементов в данной области (в данном случае используются данные численности населения или 

количество домохозяйств). 
Прежде чем использовать обозначения с градуировкой нужно стандартизировать данные о населении по площади, а затем 

создать поле с информацией о плотности населения. 

Сначала нужно создать поле, в котором хранится площадь полигона для каждой области. 

a. Загрузите заново или создайте копию слоя 1WI_EA_Pop_20936.shp. 

b. Откройте таблицу Attribute Table, а затем окно Field Calculator (Калькулятор площади)  

c. С помощью Field Calculator мы создадим поле, соответствующее плотности населения. 

d. В поле Output field name (Имя выходного поля) введите: area 

e. В меню Output field type (Тип выходного поля) выберите пункт Decimal number (real) (Десятичное число) с 

параметрами field length (длина поля) = 10 и precision (точность) = 2. 

f. В поле Expression (Выражение) введите: $area / 1000000 (Обратите внимание, что при использовании системы 

WGS 84 QGIS по умолчанию вычисляет площадь в квадратных метрах; деление на 1 000 000 даст значение в 

квадратных километрах, которое чаще всего используется в измерении плотности населения.) 

g. Нажмите кнопку OK и убедитесь, что поле в таблице Attribute Table создано правильно. 

Вычислим плотность населения, поделив численность населения на площадь. 

h. В поле Output field name (Тип выходного поля), введите: pop_dens 

i. В меню Output field type (Тип выходного поля) выберите пункт Decimal number (real) (Десятичное число) с 

параметрами field length (длина поля) = 10 и precision (точность) = 2. 

j. В поле Expression (Выражение) введите: "TOT_POP" / "area" 

k. Нажмите кнопку OK и убедитесь, что поле в таблице Attribute Table создано правильно. 
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После создания поля плотности населения можно приступать к построению хороплета. 
l. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения). 
m. В верхнем выпадающем меню выберите пункт Graduated (С градуировкой). 
n. В разделе Column (Столбец) выберите поле pop_dens. 
o. Нажмите на стрелку справа от кнопки Color ramp (Цветовая шкала), чтобы открыть выпадающее меню. 
p. Выберите одну из предложенных цветовых шкал. 
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q. В меню Mode (Режим) выберите метод Quantile (Equal Count) (Квантиль (равномерная шкала) для классификации 

данных. 
r. В меню Classes (Классы) выберите значение 5 и нажмите кнопку Classify (Классификация). 

 
 

s. Нажмите кнопку OK. 
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Плотность населения лучше отображать цветовыми шкалами в зеленых, оранжевых или коричневых тонах. Рекомендуется 

использовать цвета с максимально различимыми оттенками. На изображении ниже приведены несколько палитр, 

предложенных сайтом COLORBREWER 2.0 (http://colorbrewer2.org).  

 

 

Палитры Colour brewer доступны в QGIS. 

a. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения), 

затем нажмите на стрелку рядом с текстом Color ramp (Цветовая шкала), чтобы открыть выпадающее меню. 

b. В выпадающем меню выберите пункт Create New Color Ramp... (Создать новую цветовую шкалу), выберите пункт 

Catalog: ColorBrewer (Каталог: ColorBrewer) и нажмите кнопку OK.  

Нажмите кнопку OK, и на экране появится меню конфигурации цветовой шкалы на основе схем ColorBrewer. 
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Обозначения по правилам 

В QGIS можно задать правила, управляющие оформлением слоя. В данном случае мы настроим присвоение различных 

символов областям исследования в зависимости от преобладания пола в структуре населения. 

a. Перезагрузите или создайте копию слоя MWI_EA_Pop_20936.shj. 

b. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения). 

c. В верхнем выпадающем меню выберите пункт Rule-based (По правилам). 

d. Нажмите кнопку , чтобы добавить первое правило. Появится панель Edit Rule (Редактирование правила). 

e. В поле Label (Метка) введите текст male или другое подходящее вашим задачам имя. 

f. В разделе Filter (Фильтр), нажмите кнопку  и введите выражение “MALE”>”FEMALE” в поле Expression 

(Выражение), а затем нажмите кнопку OK. 

g. Нажмите кнопку Test (Тест) для проверки работоспособности выражения. Выберите цвет для символа и нажмите 

кнопку OK. 
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h. Нажмите кнопку , для добавления второго правила. 

i. В поле Label (Метка) введите: female 

j. Отметьте пункт Else (Иначе). Это позволит учесть все области, которые не охватывают предыдущие правила. В 

данном случае это правило будет учитывать области, где женщин меньше, чем мужчин. 

k. Нажмите кнопку OK и проверьте результат на интерфейсе карты. 
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5.6 Расширенная маркировка 

В этом разделе рассматриваются способы улучшения маркировки для повышения качества и читаемости отображаемой 

информации. 

5.6.1  Произвольное размещение меток 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите файлы 5_polygon_layers/Layers/CHL_Datos_Censo_2017_ Provincia_4326.shp и 
5_polygon_layers/Layers/SAmerica_ bkground_4326.shp 

c. Выберите слой CHL_Datos_Censo_2017_Provincia_4326.shp, откройте панельLayer Properties (Свойства слоя) и 

перейдите в раздел Labels (Метки). Создайте метки с помощью поля NOM_PROVIN и задайте соответствующий 

формат для улучшения читаемости слоев. 
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Обратите внимание, что на изображении выше отсутствуют некоторые метки. При большом количестве меток на карте 

QGIS по умолчанию скрывает метки, которые перекрываются с другими. 

d. Чтобы изменить это поведение, в разделе Labels (Метки) выберите подменю Rendering (Отрисовка) и отметьте 

вариант Show all labels for this layer (Показывать все метки на этом слое). 
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Для решения проблемы с размещением меток мы будем использовать встроенный движок маркировки из состава QGIS 

3.4 LTR. Помимо других функций, этот инструмент позволяет менять каждую метку как независимую единицу и 

устанавливать положение каждой метки вручную, что очень полезно при разработке карт с большим количеством меток. 

e. Если эта панель  не отображается в верхнем меню, то щелкните по нему 

правой кнопкой мыши и в подменю Toolbars (Панели инструментов) выберите пункт Labels Toolbar (Панель 
меток). 

f. Нажмите кнопку , чтобы открыть меню Layer Styling (Оформление уровня). 

g. Чтобы отобразить или скрыть метки, нажмите кнопку . Скрыть метку можно щелчком левой кнопки мыши при 

нажатой клавише Shift. Чтобы снова отобразить метку, щелкните по элементу. 

h. Чтобы изменить расположение меток, нажмите кнопку , затем нажмите и удерживайте одну из меток и 

перетащите ее в новое положение. 

i. Чтобы повернуть метки, нажмите , а затем щелкните и удерживайте метку для изменения ее ориентации. 

j. Для изменения формата отдельной метки нажмите кнопку , а затем щелкните по метке, которую вы хотите 

изменить. Появится меню, позволяющее настроить параметры, включая шрифт и контур. 
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Мы все еще можем настраивать параметры из меню Labels (Метки) в окне Layer Properties (Свойства слоя). Важно 

помнить, что после выбора инструмента на панели Labels Toolbar панель Labels Toolbar станет единственным способом 

настройки, заменяющим меню Labels (Метки) . Тем не менее, вы можете вернуть управление с помощью меню меток. 

Например, чтобы вернуть возможность менять размер в меню Labels (Метки), нажмите кнопку , а затем выберите 

пункт Deactivate (Выключить). Кнопка примет вид . Теперь параметр будет управляться только из меню. 

 

 

 

5.6.2 Полная система условных обозначений слоя с метками 
В этом упражнении мы будем использовать метки для добавления дополнительной информации на карту. Например, мы 

отобразим демографические данные по каждому районному совету на метках с помощью команд на простом языке 

выражений QGIS. 

a. Загрузите файлы 5_polygon_layers/Layers/CHL_Datos_Censo_2017_ Region_4326.shp и 
5_polygon_layers/Layers/SAmerica_ bkground_4326.shp 

b. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Labels (Метки). Выберите вариант Single 

Labels (Одиночные метки) и нажмите кнопку . 

c. Введите следующее выражение: "NOM_REGION" ||' (Tpop: '|| (format_number( "TOTAL_PERS",0))||')' 

d. Измените настройки (размер шрифта, контур), чтобы улучшить читаемость слоев. 
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Используя выражение, мы добавим значения в метки без необходимости создания новых полей. 

e. Введите выражение "NOM_REGION" ||' (Sex ratio: '||(format_number(("HOMBRES"/ "MUJERES" *100),1)) || '%)', 
чтобы добавить данные о соотношении полов по каждому районному совету в метку. 
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Обратите внимание, что мы могли бы создать новое поле в таблице атрибутов, использующее выражение 

(format_number(("HOMBRES"/ "MUJERES" *100),1)), и это новое поле можно было бы использовать для управления 

содержимым слоев. Тем не менее, вышеуказанный метод реализуется быстрее и более гибок. 

Кроме того, с помощью выражений можно задавать цвет меток. 

f. В разделе Labels (Метки) перейдите в подраздел Text (Текст) и с правой стороны кнопки Color (Цвет) нажмите 

кнопку  и выберите пункт Edit (Редактировать). 

 

 

g. Появится панель Expression String Builder (Мастер выражений) . Введите следующее выражение: 

case when ( "HOMBRES" > "MUJERES" ) then color_rgb(0,0,255) else color_rgb(255,0,0)end 

Теперь на карте можно увидеть, что метки меняют цвет в зависимости от значения соотношения полов (больше или 

меньше 100%). 
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В качестве альтернативы выражению можно было использовать вариант маркировки на основе правил. В этом случае 

необходимость в выражениях не отпадает, но они будут проще  

a. Загрузите слой 5_polygon_layers/Layers/CHL_Datos_Censo_2017_ Region_4326.shp 
b. Откройте панель Layer Properties (Свойства слоя) и перейдите в раздел Labels (Метки). Выберите вариант Rule-

based labeling (Маркировка по правилам) и нажмите кнопку  для добавления нового правила.  
c. В разделе Filter (Фильтр) добавьте следующее выражение для случая, когда количество мужчин превышает 

количество женщин: "HOMBRES" > "MUJERES" 

d. В поле Value (Значение) нам все еще нужно ввести то же выражение для получения составных меток: 

e. "NOM_REGION" ||' (Sex ratio: '||(format_number(("HOMBRES"/ "MUJERES" *100),1)) || '%)' 
f. Настройте параметр Color (Цвет) (например, темно-серый), Buffer (Контур) и другие параметры для улучшения 

читаемости. 
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g. Добавьте новое правило . 

h. В поле Filter (Фильтр) введите следующее выражение: "HOMBRES" < "MUJERES" 

i. Другой вариант — отметить условие Else (Иначе). 

j. Используйте то же выражение для меток в поле Value (Значение). 

k. Задайте цвет (оранжевый), контур и другие параметры для улучшения читаемости. 
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6 СЛОИ ПОЛИГОНОВ: ОБЛАСТИ 
УЧЕТА  
(РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 

 

6.1 Очистка топологии: Поиск и устранение 
пробелов, ошибок геометрии и перекрывающихся 
областей 
QGIS имеет набор инструментов с функцией прилипания / пересечения, которые полезны для создания 

новых элементов без ошибок в топологии. Для слоев, которые уже содержат ошибки, есть плагин, который 

упрощает утомительный поиск и исправление зачастую очень небольших перекрывающихся областей, 

пробелов и т. д. 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите файл 6_polygon_layers_advanced/layers/EAs_toclean_3460.shp. 

Рекомендуется создать копию файла и вносить изменения в копию, а не в оригинал. Мы сохраним 

оригинал в качестве резервной копии на случай каких-либо непоправимых ошибок. 

c. Выберите в меню пункт Plugins > Manage and Install Plugins (Плагины > Управление и установка 
плагинов) и убедитесь, что плагин Topology Checker установлен и включен. 

d. Откройте панель Topology Checker (Проверка топологии) из меню выбором пункта Vector > 

Topology Checker (Вектор > Проверка топологии) или нажатием кнопки  в верхнем меню. На 

экране появится панель, аналогичная показанной ниже. 

  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

121 

 

e. Нажмите кнопку Configure (Конфигурация) . Появится окно Topology Rule Settings (Настройки правил 
топологии). 

f. В первом выпадающем меню выберите слой, на котором будет происходить проверка топологии; в данном случае это 

будет файл EAs_toclean_3460.shp 

g. В следующем выпадающем меню выберите пункт must not have gaps (Не должно быть пробелов) (с этим параметром 

инструмент проводит поиск пробелов на слое). Нажмите кнопку  

и новое правило будет добавлено на панель ниже. 

h. Повторите ту же операцию для правил must not have invalid geometries (не должно быть ошибок геометрии) и must 

not overlap (не должно быть перекрывающихся областей), а затем нажмите кнопку OK. 

Нажмите кнопку  для проверки всех правил, примененных к слою. Будет показан список топологических ошибок. 

Отметьте пункт Show Errors (Показывать ошибки) в левом нижнем углу меню для подсвечивания ошибок на карте. 

  

Добавление  
правила 
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Прежде чем приступать к исправлению ошибок, нужно перейти в режим редактирования . 

Убедитесь, что инструмент Snapping (Прилипание)  включен, и что параметр Topological editing (Редактирование 

топологии) отключен. 

Убедитесь, что система координат в проекте одинакова   как для слоя, так и для проекта, чтобы карта масштабировалась 

правильно при выборе ошибок, подлежащих исправлению. 

Устранение пробелов 

При работе с административными границами все полигоны должны образовывать непрерывную поверхность без зазоров 

внутри или между полигонами. Важно помнить, что два полигона с совпадающими границами должны поддерживать 

соединение NODE-TO-NODE. Это означает, что если привязать узел к стороне соседнего полигона, без соединения с уже 

существующими узлами, это будет считаться разрывом, даже если между двумя полигонами нет пробелов. 

a. На панели Topology Checker (Проверка топологии) щелкните по одной из ошибок пробелов и на карте отобразится 

приближенное изображение этого участка. Отключите параметр Show errors (Показывать ошибки) для улучшения 

видимости пробела. 

b. Включите инструмент Vertex Tool (Инструмент вершин)  щелкните по вершине и перетащите ее так, чтобы она 

совпала с противоположной вершиной. 
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c. При необходимости создать или удалить вершину для устранения топологической ошибки вам нужно выполнить 

следующие действия. Создание вершины: Наведите курсор на границу полигона. В середине сегмента появится (но не 

создастся) новый узел. Щелкните по нему и переместите в нужное положение. 

Удаление вершины: Выберите вершину, щелкнув по ней при нажатой клавише Shift, или выделив несколько вершин 

мышью с помощью рамки выделения. Цвет выбранных вершин изменится на синий. Для удаления выбранных вершин 

нажмите клавишу Delete. 

d. Нажмите кнопку Validate Extent (Проверить расстояние)  для проверки наличия пробелов в исправляемой области. 

Если проблемы топологии устранены, то список на панели Topology Checker будет пуст. Нажмите кнопку Validate All 

(Проверить все)  еще раз и устраните еще несколько пробелов для наилучшего усвоения процесса. 

e. Нажмите кнопку  для сохранения изменений.  

Устранение ошибок геометрии 

Ошибка геометрии означает неправильную структуру полигона. 

a. На панели Topology Checker выберите одну из ошибок Invalid Geometry, чтобы приблизить изображение карты с этим 

местом. 

Чаще всего ошибки геометрии возникают при перекрытии одной или нескольких вершин. 

b. Выберите инструмент Vertex Tool  и заблокируйте полигон щелчком правой кнопки мыши. Перекрывающиеся 

вершины легко обнаружить, так как они подсвечиваются зеленым крестом. Для исправления ошибок этого типа 

необходимо удалить или отделить перекрывающую вершину. 
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В других случаях полигон полностью сжимается, превращаясь в линию. 

 

 
 

Устранение перекрывающихся областей 
a. На панели Topology Checker выберите одну из ошибок с названием overlap, чтобы приблизить карту в месте 

возникновения ошибки. Обратите внимание, что весь полигон, содержащий ошибку, выделен зеленым цветом. 

Данная проблема заключается в том, что мы не знаем точного местоположения перекрывающейся области. В большинстве 

случаев поиск этой области долог и утомителен, но его можно ускорить с помощью стандартного инструмента проверки 

геометрии. 

b. Покиньте режим редактирования  для слоя EAs_toclean_3460. 
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c. Выберите пункт меню Vector > Check Geometries (Вектор > Проверка геометрии). чтобы открыть панель Check 
Geometries . (Если панель Check Geometries. недоступна в верхнем меню, то выберите пункт Plugins > Manage and 
Install Plugins... (Плагины > Управление и установка плагинов...) для включения плагина. В главе 2.2 приведены 

инструкции по включению и выключению плагинов) 

d Выберите вкладку Setup (Настройка) для конфигурации проверок, проводимых инструментом. 

e. В списке Input vector layers (Входные векторные слои) убедитесь, что слой EAs_toclean_3460 выбран. 

f. В разделе Allowed geometry types (Допустимые типы геометрии) выберите пункты Polygon (Полигон) и Multipolygon 
(Мультиполигон). 

g Учитывая, что наша основная цель состоит в точном определении перекрывающихся областей, нам нужно снять галочки со 

всех параметров, включенных по умолчанию в разделах Geometry validity (Правильность геометрии), Geometry 
properties (Свойства геометрии) и Geometry conditions (Условия геометрии) . 

h. В разделе Topology checks (Проверки топологии) выберите пункт Check for overlaps smaller than (map units sqr.) 
(Проверка на перекрывающие области площадью менее (кв. ед. изм. карты.)) и оставьте значение по умолчанию 

0,0000 

i. В разделе Output vector layers (Выходные векторные слои) отметьте пункт Create new layers (Создать новые слои) и 

выберите формат и место сохранения нового слоя. 

j. Нажмите кнопку Run (Запуск) для запуска процесса проверки. 
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k. После завершения процесса автоматически откроется вкладка Result (Результат) с отображением всех 

перекрывающихся областей в таблице Geometry check result (Результат проверки геометрии). 

l. В разделе When a row is selected, move to canvas to (При выборе строки переходить на холст...), выберите 

параметры Error (К ошибке) и Highlight contour of selected features (Подсвечивать контур выбранных 
элементов). 

Инструмент проверки создаст новый уровень под названием overlapsEAs_ toclean_3460, который будет добавлен в список 

слоев на панели Layers (слои). 

m. Поместите этот новый уровень под слоем EAs_toclean_3460. Мы будем использовать слой 

overlapsEAs_toclean_3460 для выявления ошибок, но редактировать мы будем слой EAs_toclean_3460. 

n. Перейдите в режим редактирования  для слоя EAs_toclean_3460.  
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o. Затем на панели Check Geometries (Проверка геометрии) выберите одну из строк таблицы. Карта отобразит 

точное местоположение перекрывающейся области желтым цветом и очертит его красным кругом. 

p. С помощью инструмента Vertex Tool перетащите, создайте или удалите узлы в соответствии с границами, 

устраняя отсутствующие или несовмещенные вершины границы. Это одна из основных причин возникновения 

перекрывающихся областей. 
q. Прежде чем приступать к обработке перекрывающихся областей рекомендуется сначала устранить все пробелы, 

поскольку пробелы и перекрывающиеся области между полигонами зачастую бывают связаны друг с другом. 

r. Не забывайте регулярно сохранять изменения, нажимая на кнопку . 

Перед работой с полигональным слоем рекомендуется проверить и исправить его топологию. Ошибки топологии могут 

приводить различным проблемам при проведении более сложных операций со слоями. 

6.2 Подключение таблицы 
В этом разделе рассматривается импорт внешних данных из таблицы и подключение их к файлу shapefile. Сначала нужно 

загрузить файл shapefile с картой районов на Соломоновых островах. 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите файл 6_polygon_layers_advanced/layers/Sol_Ward_4326.shp 

c. Откройте таблицу Attribute table  и проверьте доступную информацию, включая коды и названия районов и 

провинций. 
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При импорте таблиц в QGIS важно иметь в виду, что программа не поддерживает файлы .xls или .xlsx. Следовательно, 

все таблицы формата Excel следует сохранять в формате CSV (MS-DOS). Импортируемая таблица содержит данные о 

водоснабжении и санитарно-технических сооружениях, полученные в ходе переписи 2009 года по районам. 

d. Выберите пункт Layer > Data Source Manager (Слой > Менеджер источников данных) или нажмите кнопку . 

e. Перейдите в раздел Delimited Text (Текст с разделителями). 

f.  В разделе File Name (Имя файла) выберите файл 6_polygon_layers_advanced/tables/solomon_ data.csv 

g. В разделе File Format (Формат файла) выберите вариант CSV (значения, разделенные запятыми). 

h. В разделе Geometry Definition (Определение геометрии) выберите параметр No geometry (Без геометрии). 

i. Проверьте раздел Sample Data (Данные выборки) и убедитесь, что данные в порядке, а затем нажмите кнопку Add 
(Добавить). Таблица появится на панели Layers (Слои) . 

Далее следует провести импорт данных внешней таблицы в таблицу атрибутов файла shapefile и и добавить новые поля к 

слою. 

j. Откройте файл Sol_Ward_4326.shp из панели Layer Properties (Свойства слоя) и перейдите в раздел Joins 
(Слияния). 

k Нажмите кнопку  , чтобы открыть меню Add Vector Join (Добавить слияние векторных данных). 

l. В разделе Join layer (Слой слияния) выберите solomon_data 

m. В разделе Join field (Поле слияния) выберите пункт Code 

n. В разделе Target field (Целевое поле) выберите WID 

o. В разделе Joined Fields (Объединенные поля) выберите поля, которые вы хотите перенести из таблицы 

solomon_data в таблицу атрибутов выбранного слоя. В данном случае мы выберем все поля, кроме Code и Ward, 

поскольку они уже добавлены на слой. 

p. Удалите весь текст, появляющийся по умолчанию в поле Custom Field Name Prefix (Префикс собственного имени 
поля). 
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q. Нажмите кнопку OK и проверьте, добавлены ли новые поля в таблицу Attribute Table . 

Обратите внимание, что на данный момент эти поля являются временными. Чтобы окончательно сохранить поля в таблице 

атрибутов слоя, нужно сохранить слой с прикрепленной таблицей в качестве нового файла shapefile. 

r. Щелкните правой кнопкой мыши по слою и выберите пункт Export > Save Features As… (Экспорт > Сохранить 
элементы как…)  

s. Введите имя и расположение нового слоя и нажмите кнопку OK. Мы назовем этот слой Sol_ward_censusdata.shp 

  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

130 

6.3 Калькулятор поля:  
Основные выражения 
В этом разделе рассматривается применение калькулятора поля для обработки данных, импортируемых из таблиц, и для 

подготовки полей с показателями водоснабжения и санитарно-технических сооружений, которые можно отобразить на 

карте с помощью хороплетов (это оформление следует использовать с количественными или процентными показателями). 

a. Загрузите 6_polygon_layers_advanced/layers/Sol_Ward_ CensusDatatest_4326.shp 

Используя импортированные поля, мы создадим следующие показатели водоснабжения, санитарии и гигиены (WASH): 

процент домохозяйств с доступом к источникам безопасной питьевой воды и процент домохозяйств с доступом к 

безопасным туалетам. В данном случае источниками безопасной питьевой воды мы будем считать водопроводы и 

резервуары. Безопасными туалетами будут считаться туалеты со смывом и гидрозатвором. Это практическое упражнение 

в ГИС, и мы понимаем, что технические требования WASH по классификации безопасности водоснабжения и 

водоотведения гораздо более сложны.  Следовательно, результаты этого упражнения не следует считать результатами 

сравнительного анализа. 

b. Откройте таблицу Attribute Table и нажмите кнопку , чтобы открыть инструмент Calculator (Калькулятор). 

c. Отметьте параметр Create a new field (Создать новое поле). 

d. В поле Output field name (Имя выходного поля), введите: safe_water 

e. В меню Output field type (Тип выходного поля), выберите пункт Decimal Number (real) (Десятичное число). 

f. В поле Output field length (Длина выходного поля), укажите значение 3, а для параметра Precision (Точность), 
укажите значение 2 (мы будем работать с процентными значениями вроде 20,25% или 100,00%, и следовательно, нам 

не нужна большая точность знаков после запятой). 

g. В поле Expression (Выражение) введите следующую формулу: (to_int( "piped_w" ) + to_int( "tank_w" ) )/ to_int( 
"tot_HH" ) * 100 

Обратите внимание, что в формуле вычисления процентного значения ( "piped_w" + "tank_w" / "tot_HH" * 100 ) мы 

должны добавить оператор to_int (преобразование в целое число), поскольку поля хранятся в формате string 

(последовательность символов или строка). При использовании строковых полей, оператор + складывает символы (52 + 

83 = 5283), не выполняя нужную нам математическую операцию (52 + 83 = 135). 

h. Для получения поля safe_toile выполните те же действия, но в качестве формулы используйте следующее выражение: 

(to_int( "flush_t" ) + to_int( "wtrseal_t" ) )/ to_int( "tot_HH" ) *100 

i. Не забывайте сохранять изменения в shapefile, нажимая кнопку  

Эти расчеты можно было бы выполнить в Excel, а затем импортировать таблицу в QGIS и связать ее с файлом shapefile. 

QGIS не ограничивает возможности одним способом решения проблем; каждый пользователь может найти собственный 

способ решения задач. Суть данного упражнения заключается в демонстрации возможности получения новой информации 

в таблице Attribute Table. 
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Теперь попробуйте вывести на карту показатели safe_water и safe_toile с помощью цветовой шкалы на основе 

материала, усвоенного в предыдущих главах. Карты такого типа очень удобны для планировщиков и ответственных лиц 

при определении областей, где необходимо улучшение условий водоснабжения и водоотведения.  
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6.4 Работа с таблицами атрибутов 
В предыдущих главах рассматривались операции выбора элементов по пространственным условиям (например, выбор 

точек в пределах полигонов). С помощью таблицы Attribute Table, можно, используя логические выражения, отбирать и 

фильтровать данные по каждому полю, аналогично работе в табличном процессоре. 

Ниже приведены примеры выбора и фильтрации с помощью таблицы Attribute Table. 

 

a. Загрузите файл 6_polygon_layers_advanced/layers/Sol_ward_Data.shp 

b. Откройте таблицу Attribute Table слоя Sol_ward_Data.shp. Обратите внимание, что поле tot_HH теперь имеет 

целочисленный формат (это легко понять, взглянув на выравнивание содержимого по правому краю, или проверив это 

в разделеSource Fields (Исходные поля) на панели Layer Properties (Свойства слоя)). 

c. Щелкните по каждой строке для выбора элемента, и строка окрасится в синий цвет. Одновременно с этим в заголовке 

панели вы увидите сообщение с указанием количества выделенных или отфильтрованных элементов. 

d. Щелчком левой кнопкой мыши при нажатой клавише CTRL можно добавлять элементы по одному к текущей выборке. 

 

 

 

e. Щелчком левой кнопкой мыши при нажатой клавише SHIFT можно выделять все элементы между первым и последним 

выделенным элементом. 
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f. Нажмите кнопку   для добавления или удаления элементов из списка выбранного. 

g. Нажмите кнопку , чтобы инвертировать выделение. 

h. Чтобы выбрать все элементы, нужно щелкнуть по верхнему левому углу таблицы или нажать кнопку . 

i. Чтобы показать выбранный элемент на карте, нажмите кнопку , и на карте отобразится выбранный элемент. 

Нажмите кнопку , чтобы открыть панель Select by Expression (Выбор по выражению). В поле Expression 

(Выражение), введите следующее простое выражение:  

"PName" = 'Choiseul' 

Затем нажмите кнопку Select features (Выбрать элементы), а затем нажмите кнопку Close (Закрыть). 

j. Нажмите кнопку  для отображения результата выбора на карте. Мы выбрали все районы, принадлежащие 

провинции Хойсюл. 

k. Если вам нужно добавить к этой выборке районы Гуадалканала, то перейдите на панель Select by Expression (Выбор 

по выражению) . 

l. Введите следующее выражение: "PName" = 'Guadalcanal' 

m. Нажмите на стрелку рядом с кнопкой Select features (Выбор элементов) и выберите пункт Add to current selection 

(Добавить к текущей выборке). 

  



QGIS КАК ИНСТРУМЕНТ ЦИФРОВОЙ КАРТОГРАФИИ В ПЕРЕПИСЯХ И ИССЛЕДОВАНИЯХ | СЛОИ ПОЛИГОНОВ: ОБЛАСТИ УЧЕТА (РАСШИРЕННЫЙ ВЕКТОРНЫЙ АНАЛИЗ) 
 

134 

 
 

Выборка будет добавлена к предыдущей. 

Выберем районы, где процент домохозяйств с доступом к безопасным туалетам ниже 50% и с количеством домохозяйств 

больше 1000. Для этого можно использовать два метода. Во-первых, можно вызвать панель Select by Expression (Выбор 

по выражению)  и ввести следующее выражение:  

"safejoile" < 50 and "tot_HH" >1000 

Но если вам неудобно использовать выражения, то используйте инструмент Select/Filter Features using form (Выбор / 
фильтр элементов по форме). 

a. Откройте таблицу Attribute table и нажмите кнопку , чтобы открыть меню. 

b. В поле tot_HH введите значение 1000 и выберите пункт Greater than (>) с помощью кнопки, расположенной справа. 

c. В поле safe_toile введите значение 50 и выберите пункт Less than (<). 

d. Нажмите кнопку Select features и проверьте, какие районы были выделены в таблице и на карте. 
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6.5  Растворение 
В этой главе рассматривается создание слоя провинции из слоя районов. 

a. Загрузите файл 6_polygon_layers_advanced/layers/Sol_Ward_4326.shp 

b. В верхнем меню выберите пункт Vector > Geoprocessing Tools > Dissolve (Вектор > Инструменты обработки 
географических данных > Растворение). На экране появится меню. 

c. В разделе Input layer (Входной слой) выберите файл Sol_Ward_4326.shp 

d. В разделе Dissolve field (Поле растворения) нажмите кнопку  и выберите пункт pid (код провинций). 

e. В разделе Dissolved (Слой с результатами) выберите расположение и имя нового слоя (например, Sol_prov.shp). 

Слой провинции отобразится в интерфейсе карты. Проверив таблицу атрибутов, вы увидите 10 элементов, 

представляющих провинции. Иерархическая взаимосвязь между различными уровнями в таблице атрибутов самого низкого 

административного уровня позволяет создавать верхние уровни с помощью инструмента растворения. 

6.6  Создание буферных областей 
В этой главе рассматривается создание прибрежной полосы шириной 1 км, которая включает в себя районы страны, 

расположенные на расстоянии менее 1 км от моря. 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите файл 6_polygon_layers_advanced/layers/DMA_Land_4326.shp 

c. В верхнем меню, выберите пункт Vector > Geoprocessing Tools > Buffer (Вектор > Инструменты географической 
обработки данных > Буферная область). На экране появится меню инструмента. 

d. В разделе Input layer (Входной слой) выберите слой DMA_Land_4326.shp 

e. В разделе Distance (Расстояние) обратите внимание, что значения вводятся в градусах. В районах, близких к 

экватору, 1 градус приблизительно равен 111 км. Чтобы задать буфер шириной около 1 км, нужно ввести значение 
0,01 

f. Параметр Segments (Сегменты) управляет количеством сегментов генерируемой линии для создания четверти круга 

при отрисовке буфера.  

Чем выше значение, тем точнее нарисован полученный буферный объект. В нашем случае мы используем значение в 
20 сегментов. 

g. В разделе Buffered (Слой буферной зоны) оставьте значение по умолчанию. Нажмите кнопку Run (Запустить). 
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h. Если приведенная выше буферная зона не отобразится на карте, то попробуйте отсортировать слои на панели Layers 

(Слои), чтобы слой Buffered находился под слоем DMA_ Land_4326.shp 
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Созданный слой — это поверхность, расширяющая площадь полигона на 1 км по контуру в сторону моря. А мы 

планировали создать полосу в границах острова шириной 1 км. Для достижения этой цели выполните приведенные ниже 

действия. Существуют более быстрые способы выполнения этой задачи, но эти действия предусматривают больше 

взаимодействия с основными инструментами обработки, доступными в QGIS. 

Преобразование полигонов в линии 

Этот алгоритм создает слой с полосой на основе слоя с полигоном. 

Во-первых, нам нужно преобразовать полигон в линию. Это необходимо, поскольку если применить буферный инструмент к 

слою линии, буферная область будет создана по обеим сторонам линии. 

a. В верхнем меню выберите пункт Vector > Geometry Tools > Polygons to Lines... (Вектор > Инструменты геометрии 
> Преобразование полигонов в линии...). 

b. В разделе Input layer (Входной слой) выберите слой DMA_Land_4326.shp 

c. В разделе Lines (Линии) оставьте значение по умолчанию. Нажмите кнопку Run (Запустить). 

 

 

 

Создание буфера шириной 1 км вокруг линейного объекта 

a. В верхнем меню выберите пункт Vector > Geoprocessing Tools > Buffer (Вектор > Инструменты 
географической обработки данных > Буферная область). На экране появится меню. 

b. В разделе Input layer (Входной слой) выберите пункт Lines (Линии) 

c. В разделеDistance (Расстояние) введите значение 0.01 

d. В разделе Segments (Сегменты) введите значение 20 сегментов. 

e. В разделе Buffered (Слой буферной зоны) оставьте значение по умолчанию. Нажмите кнопку Run (Запустить). 
(Обратите внимание, что этот процесс может занять несколько минут).  
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Извлечение части буфера 

На этом этапе мы удалим отрезок буферной зоны со стороны океана. Чтобы выполнить эту операцию, нужно ОТСЕЧЬ 

текущую буферную зону с помощью слоя DMA_Land_4326.shp. 

a. В верхнем меню выберите пункт Vector > Geoprocessing Tools > Clip (Вектор > Инструменты географической 
обработки данных > Отсечение). На экране появится меню инструмента. 

b. В разделе Input layer (Входной слой) выберите буфер, полученный из линейного слоя предыдущей процедурой. 

c. В разделе Output layer (Выходной слой) выберите слой DMA_Land_4326.shp 

d. В разделе Clipped (Результат отсечения) введите имя файла прибрежной зоны шириной 1 км (например, 
1kmBuffer_4326.shp). 
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e. Нажмите кнопку Run (Запустить) и убедитесь, что результат на карте аналогичен слою, показанному зеленым цветом 

на рисунке ниже. 
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6.7  Поиск ближайших элементов к 
домохозяйствам — школы 
В данном разделе рассматривается определение расстояния между двумя точками. Мы проведем вычисление расстояния 

от каждого домохозяйства (эти точки были созданы случайно) до ближайшей школы в провинции Газа (Мозамбик). 

Полученный слой поможет нам оценить доступность школ в этой провинции. 

a. Нажмите кнопку , чтобы создать новый проект. 

b. Загрузите файлы 6_polygon_layers_advanced/layers/MOZ_GazaProv_4326 shp, 

6_polygon_layers_advanced/layers/Roads_Gaza_4326.shp,  

6_polygon_layers_advanced/layers/Households_4326.shp и 6_polygon_layers_advanced/layers/Schools_4326.shp 

c. Отсортируйте слои на панели Layers (Слои), чтобы убедиться, что слои домохозяйств и школ отображаются над 

слоями провинций и дорог. 

d. В верхнем меню выберите пункт Processing > Toolbox (Обработка > Инструментарий), чтобы открыть панель 
Processing Toolbox (Инструменты обработки). 

e. В поле поиска, расположенное в верхней части панели Processing Toolbox , введите текст hub distance, и на экране 

отобразятся результаты поиска. 

f. Выберите пункт Distance to Nearest Hub (Points) (Расстояние до ближайшего узла (Точки). 

g. В разделе Source points layer (Слой начальных точек) выберите слой Households. 

h. В разделе Destination hubs layer (Слой пунктов назначения) выберите слой Schools. 

i. В разделе Hub layer name attribute (Атрибут имени в слое пунктов назначения) выберите поле OBJECTID. 

j. В разделе Measurement unit (Единица измерения) выберите пункт Meters (Метры). 

k. В разделе Hub distance (Расстояние до пункта назначения) введите расположение и имя файла для нового слоя 

(например, HH_Dist2School). 

l. Нажмите кнопку Run (Запустить), а после завершения операции — кнопку Close (Закрыть). (Обратите внимание, что 

этот процесс может занять несколько минут). 
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Инструмент создал копию слоя домохозяйств, добавив новое поле, содержащее расстояние до ближайшей школы. Теперь, 

настроив условные обозначения, мы можем выделить регионы в зависимости от географической доступности школ. 

a. Выберите слой HH_Dist2School (он может иметь имя Hub distance) на панели Layers (Слои), затем откройте панель 
Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения). 

b. В верхнем выпадающем меню выберите пункт Graduated (С градуировкой). 

c. В разделе Value (Значение) выберите поле HubDist. 

d. В разделеColor ramp (Цветовая шкала) выберите наиболее подходящий вариант. В нашем случае мы выбрали 

вариант Spectral (Спектр). 

e. В разделе Mode (Режим) выберите вариант Equal interval (Равные интервалы) и нажмите кнопку Classify 
(Классификация). 

Вы заметите, что наибольшие расстояния представлены синим цветом, а наименьшие — красными, но нам нужна обратная 

картина. 

f. Щелкните правой кнопкой мыши по кнопке color ramp и выберите в меню пункт Invert Color Ramp (Инвертировать 
цветовую шкалу). Теперь обозначения выглядят логичнее. 

Чтобы лучше представлять данные, нам необходимо улучшить читаемость диапазона классификации и легенды.  
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Значения вроде 5 км читаются и запоминаются легче, чем значения вроде 4,82 км. 

g. Дважды щелкните по каждой ячейке столбца Values (Значения) и Legends (Легенды) для изменения границ 

класса и значений, которые будут отображаться на легенде. Нажмите кнопку Ok.  

 

 

 

h. Используйте особое обозначение для школ, чтобы выделить их на фоне домохозяйств. 

i. Нажмите кнопку Ok и проверьте результат на холсте карты. 
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7  АВТОМАТИЗИРОВАННОЕ 
СОЗДАНИЕ КАРТ 

Atlas (Атлас) — это автоматический инструмент построения карт для QGIS. Этот инструмент имеет важное значение при 

создании большого числа похожих карт, например при создании карт областей исследования. 

В этой главе мы начнем с готового проекта Atlas.qgz с уже заданным основным форматом, чтобы не повторять темы, 

которые уже рассмотрены в предыдущих главах. 

Учитывая сложность главы, проект под названием AtlasResult.qgz был включен в папку учебных материалов, чтобы вы 

могли использовать его при возникновении трудностей. Проект содержит все результаты упражнений, представленных в 

этой главе. 

7.1  Макет и базовая конфигурация Atlas 

a. Нажмите кнопку , чтобы открыть проект '_automated_map/Atlas.qgz. Обратите внимание, что слой 

местоположения домохозяйств и слой областей ЕА уже загружены на холст карты. 

b. Убедитесь, что слои EA_atlas_4326.shp, HH_atlas_4326.shp и фоновое спутниковое изображение добавлены на 

холст. Если это не так, то загрузите слои из папки 7_automated_map/Layers, а слой с фоновым спутниковым 

изображением загрузите из картографического сервиса XYZ tiles, который можно найти на панели Browser . 

Для атласа требуется верхний слой, управляющий построением карты. Поскольку нам нужно создать карту для каждой из 

областей исследования, в качестве верхнего слоя будет использоваться EA_atlas_4326.shp. Это означает, что Atlas 

"сфотографирует" каждую область EA и автоматически построит карты. С помощью таблицы атрибутов верхнего слоя 

можно автоматически добавлять заголовки, фильтровать карты для печати, и присваивать имена файлам. 

c. В верхней ленте меню выберите пункт Project > Layouts (Проект > Макеты) и откройте макет Atlas_ landscape . В 

интерфейсе окна Layout отобразится базовая конфигурация макета, включая холст карты и заголовок. 

d. Справа от интерфейса с различными меню макета должно отобразиться меню Atlas. Если оно не отобразилось 

автоматически, то нажмите кнопку или выберите пункт Atlas > Atlas settings (Атлас > Настройки атласа). 

e. В меню Atlas отметьте параметр Generate an atlas (Создать атлас). 

f. В разделе Coverage layer (Верхний слой), выберите слой EA_atlas_4326, поскольку на нем содержатся полигоны 

для построения нашей карты. 

g. Не включайте параметр Hidden coverage layer (Скрытый верхний слой), поскольку нам нужно отображать границ 

EA на картах. 

h. В разделе Page name (Название страницы) выберите поле eaid для назначения имен страниц по кодам EA. 

i. Оставьте параметр Filter with (Фильтровать по) без галочки. 

j. Включите параметр Sort by (Сортировать по) и выберите поле eaid для сортировки карт по коду EA. 

k. Отключите параметр Single file export when possible (Пофайловый экспорт по возможности), нажмите кнопку 

удалите выражение по умолчанию и введите следующий текст: "eaid" 
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Этот параметр автоматически добавит код EA к имени файла при экспорте атласа в формате изображения. Все значения, 

используемые для присвоения имен картам, должны быть уникальными по отношению друг к другу, в противном случае 

карты с одинаковыми именами файлов будут переименованы в процессе экспорта. 

l. В разделе Image export format (Формат изображения для экспорта) выберите нужный формат для 

экспортируемых карт. Наиболее распространенными являются форматы Jpg, .jpeg и .png. 

 

 

 

m. На холсте выберите карту и откройте меню Item Properties (Свойства элемента). Прокрутите меню вниз, 

найдите параметр Controlled by Atlas (Определяется атласом) и включите его. 

n. Выберите пункт Margin around feature (Область вокруг элемента) и задайте значение 10% 

o. В верхнем меню нажмите кнопку для включения панели Atlas Toolbar.  
Используйте кнопки  для навигации по картам.  

Используя просмотр страниц , мы можем напрямую перейти к нужной EA, поскольку мы уже настроили 

параметры Page name (Имя страницы) соответствующим образом. 
p. Не забывайте регулярно сохранять изменения в проекте нажатием на кнопку . 

Используя эту базовую конфигурацию атласа, мы обеспечиваем построение инструментом карты для каждой области 

учета по мере продвижения по областям. На этом этапе нам необходимо доработать макет, чтобы указать больше 
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информации об отображаемой области, например добавить код EA, название острова и масштаб. Инструмент Atlas может 

динамически названия, используя для этого таблицу атрибутов верхнего слоя. 

Автоматические заголовки 

a. Перейдите в раздел Layout Interface (Интерфейс макета) и нажмите кнопку . Укажите прямоугольную 

область, в которой будет находится название. 

b. Убедитесь, что рамка заголовка выбрана на холсте макета и откройте меню Item Properties (Свойства 
элемента). 

c. В разделе Main Properties (Основные свойства) щелкните по полю Insert an Expression (Вставьте 
выражение) и введите следующее выражение: 

'EA Code: '||"eaid" 

d. Настройте шрифт текста, изменив цвет, сделав его жирным и увеличив размер, чтобы сделать название более 

читаемым. 

e. Просмотрите карты с помощью кнопок , чтобы убедиться, что код EA соответствует отображенному на 

карте. 

f. Вставьте автоматические названия для островов и деревень, добавив новое текстовое поле и используя следующее 

выражение: 'Village name: '|| "v_name" ||' / Island name: '||"i_name" 

Помните, что в языке выражений QGIS символ || используется для объединения текста или переменных. Одиночные 

кавычки ' используются для обозначения текста, а двойные кавычки " обозначают поля из таблицы атрибутов. 

Автоматическая шкала масштаба 

g. Перейдите в раздел Layout Interface (Интерфейс макета) и нажмите кнопку . Укажите прямоугольную область, 

в которой будет находится название. 

h. Перейдите в меню Item Properties (Свойства элемента) и откройте подменю Units (Единицы измерения). 

i. В разделе Scalebar Units (Единицы измерения для шкалы масштаба) выберите параметр Kilometers (километры) 
и в поле Label for Units (Метка для единиц измерения) введите текст km 

j. Поскольку шкала масштаба подстраивается автоматически для предотвращения выхода элемента за поля макета, 

выберите параметр Fit segment width (Подгонять по ширине сегмента) и задайте размер от 50 до 100 мм. 
k. Затем перейдите в раздел Position and Size (Положение и размер) и задайте значение 100 мм для параметра 

Width (Ширина) рамки. 

l. Используйте кнопку , чтобы проверить, работает ли динамическая шкала масштаба. 

m. Не забывайте регулярно сохранять изменения в проекте, нажимая кнопку  В следующем разделе мы продолжим 

работать над тем же проектом и макетом. 
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7.2  Стили, основанные на правилах, 
взаимодействующие с инструментом Atlas 
(переменные Atlas) 

В этом разделе рассматривается настройка стилей для слоев EA и HH, которые будут синхронизироваться с Atlas для 

улучшения читаемости карт. 

Стиль для слоя полигона 

a. Вернитесь к основному интерфейсу QGIS и откройте файл EA_atlas_4326. На панели Layer Properties (Свойства 
слоя) перейдите в раздел Symbology (Условные обозначения). 

b. Выберите параметр Ruled-based (На основе правил) в верхнем выпадающем меню. 

c. Дважды щелкните по текущему отображаемому правилу или выберите его и нажмите кнопку , чтобы открыть 

панель Edit Rule (Редактирование правила). 

d. В поле Label (Метка) введите: Selected EA 

e. В разделе Filter (Фильтр), нажмите кнопку  и введите следующее выражение: @atlas_featureid = $id 

f. Нажмите кнопку OK. 

g. Нажмите кнопку TEST для проверки правильности работы формулы. 

h. Задайте прозрачную заливку и оранжевый контур и нажмите кнопку OK. 

i. Нажмите кнопку , чтобы добавить новое правило  

j. В поле Label (Метка) введите: Not selected EA 

k. Включите условие Else (Иначе). 

l. Задайте стиль того же типа с оранжевым цветом для параметра Stroke (Контур). 

m. Для параметра Fill (Заливка), выберите синий оттенок и задайте параметру Opacity (Непрозрачность) значение 

50%. 
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n. Нажмите кнопку OK в следующих трех меню для сохранения изменений и проверьте, применилось ли условное 

форматирование к макету Atlas_landscape. У выбранной области EA заливка должна быть прозрачная, а у 

невыбранной — полупрозрачная голубая. 

Далее, нам нужно сделать так, чтобы на карте отображались только полупрозрачные голубые метки EA. Нам не нужно 

показывать метку выбранной EA, так как она будет отображаться в названии. Кроме того, мы избегаем маркировки 

выбранного полигона для предотвращения перекрывания меткой других элементов внутри полигона, например 

местоположений HH или других меток. 

a. Вернитесь к основному интерфейсу и откройте файл EA_atlas_4326. На панели Layer Properties (Свойства слоя) 
перейдите на вкладку Labels (Метки). 

b. Выберите вариант Rule-based labelling (Присвоение меток по правилам) и нажмите кнопку  для добавления 

нового правила. На экране появится панель Edit Rule (Редактирование правила). 

c. В разделеFilter (Фильтр) нажмите кнопку  и введите следующее выражение: @atlas_ featureid <> $id, 

затем нажмите кнопку OK. 

d. Нажмите кнопку Test для проверки правильности работы формулы. 

e. В разделе Value (Значение) выберите поле eaid и задайте тот же формат метки, что и в предыдущих главах, что 

обеспечит читаемость карты. 

f. Создайте новое правило  и нажмите кнопку , чтобы открыть панель Edit Rule (Редактирование 

правила). 

g. В разделе Filter (Фильтр) нажмите кнопку  и введите следующее выражение: @atlas_ featureid = $id, но 

при этом в разделе Label with (Присваивать метку) поля нужно оставить незаполненными, чтобы метки не 

отображались. Нажмите кнопку OK. 

h. Нажмите кнопку OK в следующих меню и проверьте, чтобы условное форматирование давало ожидаемый результат. 
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Для оформления слоя точек HH мы зададим настройки, аналогичные настройкам полигонов EA. В данном случае нам 

нужно отображать и маркировать только точки, соответствующие двум условиям: точки должны быть выбраны для данного 

гипотетического исследования (точки, где Field Selected принимает значение 1), и они должны быть расположены в 

пределах EA, выбранной инструментом Atlas. 

a. Откройте файл HH_atlas_4326. На панели Layer Properties (Свойства слоя) перейдите в раздел Symbology 
(Условные обозначения). 

b. Выберите вариант Ruled-based (На основе правил) в верхнем выпадающем меню. 

c. Дважды щелкните по текущему отображаемому правилу или выберите его и нажмите кнопку , чтобы открыть 

панель Edit Rule (Редактирование правила). 

d. В поле Label (Метка), введите: Selected HH 

e. В разделе Filter нажмите кнопку  и введите следующую формулу для выполнения условий для слоя 

расположения домохозяйств: 

"Selected" = 1 and intersects(@atlas_geometry, $geometry) 

f. Нажмите кнопку Test для проверки правильности работы формулы. 

g. Настройте стиль, чтобы точки лучше выделялись на фоне спутникового изображения. 

h. Создайте новое правило  и нажмите кнопку , чтобы открыть панель Edit Rule, а затем нажмите кнопку OK. 

В данном случае конфигурация меток будет простой — достаточно лишь задать базовые метки с отображением 

идентификатора HH. 

i. Перейдите в раздел Labels и выберите вариант Single labels (Одиночные метки). 

j. Для параметра Label with (Маркировка по), выберите поле id. 

k. Настройте стиль, увеличив размер шрифта и добавив белый контур для улучшения читаемости кодов HH на картах. 

l. Убедитесь, что в условное форматирование в интерфейсе Layout Interface дает ожидаемый результат, а затем 

нажмите кнопку  для сохранения изменений в проекте. 
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Для завершения конфигурации стиля нужно добавить легенду к макету. 

a. Перейдите к Atlas_landscape, нажмите кнопку  и укажите прямоугольную область, где будет располагаться 

легенда. 

b. Выберите легенду и откройте меню Item Properties (Свойства элемента). 

c. Отключите параметр Auto update (Автоматическое обновление). 

d. Выберите запись Google Satellite и нажмите кнопку  , чтобы удалить ее с легенды.  

Используйте кнопки  для определения порядка отображения элементов на легенде. 

e. Дважды щелкните по каждому из элементов для изменения названий. В данном случае мы удалим названия слоев, 

поскольку названием служит сама метка. 

 

 
 

f. Прокрутите меню вниз и откройте раздел Fonts. Настройте шрифты для каждой из следующих категорий: Title, Group, 

Subgroup и Item. 

g. В разделеColumns (Столбцы) можно настроить отображение легенды двумя столбцами. 

h. В разделе Symbol (Символ) можно увеличить или уменьшить размер символов. 

i. В разделе Spacing (Интервалы) можно изменить интервалы между элементами легенды. 
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7.3  Альбомная и портретная компоновка макета 

Глядя на карты различных EA, можно понять, что некоторые из полигонов лучше отобразить на странице с альбомной 

ориентацией, а другие — на странице с портретной ориентацией. 

 

 

 

В этом разделе рассматривается настройка атласа для автоматического определения ориентации и создания макетов карт 

как с альбомной, так и с портретной ориентацией. 
 
 

Во-первых, нужно создать поле в таблице Attribute Table, которая определяет наиболее подходящий макет для карты. 

a Перейдите на панель Layers (Слои) откройте таблицу Attribute Table для слоя EA_ atlas_4326. 

b Нажмите кнопку , чтобы открыть Field Calculator (Калькулятор поля).  

c. Включите параметр Create a new field (Создать новое поле). 

d. В поле Output field name (Имя выходного поля) введите: orient 

e. В меню Output field type (Тип выходного поля) выберите пункт Text (string) (Текст (строка)). Это очень важно, так 

как в этом поле будут храниться буквенные значения. 

f. В диалоговом окне Expression (Выражение) введите следующую формулу:  

if(bounds_width($geometry)>bounds_height($geometry),'L,'P') 

g Нажмите кнопку OK и проверьте таблицу Attribute Table — в ней должно быть правильно создано соответствующее 

поле. Это поле должно иметь заголовок orient, а в ячейках должны быть буквы L или P. 

h. Нажмите кнопку , чтобы сохранить изменения и выйти из режима редактирования. 

Теперь нужно настроить макет Atlas_landscape, чтобы на нем отображались только те EA, для которых портретная 

ориентация является оптимальной. 
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a. Перейдите в меню Atlas и включите параметр Filter with (Фильтр по). 

b. Нажмите кнопку   и введите следующее выражение: "orient" = 'L' 

 

 
 
 

c. Проверьте результат на панели Atlas Toolbar — инструмент должен выбирать только альбомно-ориентированные 

EA. 

Следующий шаг — создать копию макета с измененными ориентацией и расположением элементов карты. 

a. В верхнем меню интерфейса Layout Interface выберите пункт Layout > Duplicate Layout (Макет > Создать копию 
макета). 

b. Задайте новому макету имя Atlas_portrait 

c. Щелкните правой кнопкой мыши по холсту макета и выберите пункт Pages Properties... (Свойства страниц...) 

d. В меню Item Properties (Свойства элемента) появятся свойства страницы (размер, ориентация и цвет фона). 

e. В разделе Orientation (Ориентация) выберите пункт Portrait (Портретная).  
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f. Откройте меню Atlas. 

g В разделе Filter with (Фильтр по) замените текущее выражение следующим: "orient" = 'P' 
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h. Для завершения работы с новым макетом нужно просто перетащить и изменить размеры всех элементов карты в 

соответствии с новой конфигурацией макета.  

Как только портретные и альбомные макеты будут готовы, можно переходить к экспорту карт в файлы изображений. 

Функция атласа позволяет создавать эти карты автоматически. 

a. В верхнем меню интерфейса Layout Interface выберите пункт Atlas > Export Atlas as Images (Атлас > 

Экспортировать атлас как изображения).. Другой вариант — нажать кнопку , которая находится на панели 

Atlas Toolbar. 

b. Выберите папку, в которой вы хотите сохранить карты. 

c. На панели Image Export Options (Параметры экспорта изображения) можно настроить параметры разрешения 

изображений. В данном случае мы оставим значения по умолчанию. Нажмите кнопку Save (Сохранить). 

d. Появится окно с индикатором прогресса и указанием количества готовых карт и общего количества карт.  

Карты как в портретной, так и в альбомной ориентации будут сохранены в одну и ту же папку. Важно убедиться, что 

количество экспортированных карт равно числу EA в таблице атрибутов, и что имена файлов соответствуют кодам EA. 
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7.4 Таблицы, управляемые инструментом Atlas 
В этом разделе мы создадим макет карты, который будет содержать таблицу информации о домохозяйствах, 

отображенных на карте. Инструмент Atlas позволяет синхронизировать информацию, включенную в эти таблицы, с 

областью, отображаемой на карте. Для этого упражнения нужно создать копию макета Atlas_landscape и создать 
Atlas_landscape_ table, выполнив действия из предыдущей главы. 

a. Уменьшите размер карты и переместите шкалу масштаба, чтобы освободить место для таблицы. 

b. Нажмите кнопку   и укажите прямоугольную область макета, где будет располагаться таблица. 

c. Перейдите в меню Item Properties (Свойства элемента) и выберите подменю Main Properties (Основные 
свойства). 

d. В разделе Source (Источник), выбе рите вариант Layer features (Элементы слоя). 

e. В разделе Layer (Слой) выберите слой 1H_atlas_4326 

f. Нажмите кнопку Attributes (Атрибуты) и удалите поле HHid, выбрав его в разделе Columns (Столбцы) и нажав 

кнопку  

g. Отсортируйте поля по id, name, status. Selected выбором соответствующих заголовков и используя кнопки . 

h. В разделе Sorting  (Сортировка)выберите заголовок id, а затем выберите вариант Ascending (По возрастанию) и 

нажмите кнопку . 

i.  Нажмите кнопку OK, чтобы сохранить изменения в таблице.  
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Если проверить содержание таблицы и точки на карте, то вы увидите, что ни одна из точек в таблице не соответствует 

отображаемой на карте. Кроме того, при переходе с одной карты на другую таблица остается прежней. 

Следовательно, нам необходимо настроить параметры для синхронизации таблиц с картами. 

j. Откройте подменю Feature Filtering (Фильтрация элементов). 

k. Параметру Maximum rows (Максимальное число строк) задайте значение 30 и убедитесь, что таблица может 

вместить 30 строк. 

l. Включите параметр Show only features intersecting atlas feature (Показывать только элементы, общие с 
атласом). 

m. В поле Filter with (Фильтр по) введите следующее выражение: "Selected" = 1 

 

 

 

n. В подменю Appearance (Внешний вид), Show Grid (Показывать границы) и Fonts and Text Styling (Стили 
шрифтов и текста) собраны параметры, необходимые для работы с форматированием таблицы. 

 
С помощью этих параметров таблица синхронизируется при изменении EA по ходу перелистывания карт. Эти таблицы 

служат источником дополнительной информации для лиц, проводящих перепись (имя, адрес, количество проживающих), 

которая может быть полезной в полевой работе. 
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8 РАБОТА С РАСТРОВЫМИ 
ИЗОБРАЖЕНИЯМИ  
(ДАННЫЕ О ЛАНДШАФТЕ) 

ГИС обычно работают с двумя типами пространственных данных: векторными (точки, линии и полигоны) и растровыми. В 

предыдущих главах руководства мы работали с векторными данными, которые в большинстве случаев больше подходят 

для сбора и обработки статистических данных. 

Растровые данные состоят из матрицы (или сетки) пикселей. Каждый пиксель или ячейка содержит информацию об 

области под этим пикселем, например высота, уклон, землепользование или плотность населения. 

8.1 Получение цифровой модели высот с сервера 
NASA Earthdata 

Цифровая модель высот, или DEM, представляет собой растровую карту, пиксели в которой содержат информацию о 

высоте непрерывной поверхности. В этой главе рассматривается получение карты высот с сервиса NASA Earthdata с 

помощью плагина SRTM Downloader. 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку .  

b. Загрузите файл 8_Raster/layers/land_4326.shp на холст карты. 

c. На панели Layers (Слои) щелкните правой кнопкой мыши по слою and_4326.shp и выберите пункт Zoom to Layer 
(Приблизить к слою), чтобы изображение холста показывало содержимое выбранного слоя. Это действие 

необходимо для определения холста или плитки, которую нужно загрузить из репозитория SRTM. 

d. В верхнем меню выберите пункт Plugins > SRTM Downloader (Плагины > SRTM Downloader). Если этот плагин 

еще не установлен, то воспользуйтесь инструкциями главы 2.2 для установки плагина. 

e. Выберите пункт Plugins > SRTM Downloader или нажмите кнопку  для отображения меню плагина. 

f. Нажмите кнопку Set canvas extent (Задать область холста) для автоматического определения границ рабочей 

области. С помощью этих значений плагин загрузит соответствующие плитки карты высот с сервиса SRTM. 
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g. В разделе Output-Path (Путь вывода) выберите папку сохранения растровой карты и отметьте пункт Load Images 

to QGIS (Загрузить изображения в QGIS). 

h. Нажмите кнопку Download (Загрузить). На экране появится приведенная ниже панель с запросом данных для входа 

в сервис NASA Earthdata. Если у вас еще нет учетной записи в этом сервисе, то ее можно быстро создать здесь: 

https:// urs.earthdata.nasa.gov/users/new 

После завершения регистрации вам на почту будет направлено письмо с данными для входа. 

i. Заполните поля Username и Password, данными для входа и нажмите кнопку OK. На экране появится индикатор 

прогресса загрузки. После завершения процесса растровые файлы будут автоматически загружены на холст карты. 
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j. Растровые изображения содержат карту высот Пуэрто-Рико. Чем светлее тон, тем выше находится точка над 

уровнем моря, и наоборот.  

Если по какой-то причине процесс не сработает на вашем компьютере, то карту можно загрузить из файла 

8_Raster/DEM/PRI_AST_DEM_comp в наборе учебных материалов, прилагаемых к данному руководству. 
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8.2 Улучшение визуализации растра2 

С текущими настройками отображения, вы можете довольно легко различать оттенки высот. Тем не менее, качество 

отображения этой пространственной информации можно улучшить, создав 3D-модель поверхности, что упрощает 

интерпретацию градиента и топографии ландшафта. Для этого мы наложим слой типичной цветовой карты высот на слой 

освещенного ландшафта. Обратите внимание, что оба слоя создаются из одной и той же растровой карты. 

Освещенный ландшафт 

a. Начните новую сессию или создайте новый проект в QGIS, нажав кнопку . 

b. Загрузите файл 8_Raster/DEM/PRI_AST_DEM_comp 
c. На панели Layers (Слои) щелкните правой кнопкой мыши по файлу PRI_AST_DEM_comp, а затем выберите пункт 

Duplicate Layer (Создать копию слоя). 
d. Откройте окно Layer Properties (Свойства слоя) для слоя PRI_AST_DEM_comp copy (слой, который находится под 

исходной растровой картой) и откройте раздел Symbology (Условные обозначения). 
e. Перейдите в подменю Band Rendering (Отрисовка полос), и в выпадающем меню Render type (Тип отрисовки) 

выберите вариант Hillshade (Освещенный ландшафт). 
f. В разделе Z Factor введите значение 0,00001 
g. Включите параметр Multidirectional (Многонаправленный). В отличие от традиционных моделей освещенного 

ландшафта, где используется один источник света, в многонаправленном методе используется освещение с с 

четырех различных направлений, создавая более точную модель. 
h. В подменю Resampling (Ресемплинг) выберите пункт Zoomed (С увеличением). Параметру In (Ввод) задайте 

значение Bilinear (Билинейный); для параметра Out (Вывод) выберите значение Average (Среднее); параметру 
Oversampling (Оверсемплинг) задайте значение 2.00 

 

 
 
 

 
2  Главы 8.2 и 8.3 построены на основе следующего материала: https://opengislab.com/blog/2018/3/20/3d-dem-visualization-in-qgis-30 
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i. Нажмите кнопку OK для сохранения изменений обозначений, затем проверьте холст и убедитесь, что полученный 

результат выглядит аналогично изображению ниже.  

 

j. Щелкните правой кнопкой мыши по слою и выберите пункт Rename Layer (Удалить слой). Переименуйте слой, 

чтобы отразить его сущность (например, PRI_AST_DEM_comp hshade). 

Отображение карты высот с градуировкой цвета по высоте 

a. Откройте окно Layer Properties (Свойства слоя) для слоя PRI_AST_DEM_comp (верхний слой) и перейдите в 

раздел Symbology (Условные обозначения). 

b. Перейдите в подменю Band Rendering (Отрисовка полос), и в выпадающем меню Render type (Тип отрисовки) 
выберите вариант Singleband pseudocolor (Псевдо-текстура с одним спектром). 

c. Нажмите на кнопку со стрелкой справа от поля Color ramp (Цветовая шкала). Откроется выпадающее меню. 

Выберите пункт Create New Color Ramp (Создать новую цветовую шкалу). 
d. На панели Color ramp type (Тип цветовой шкалы) выберите пункт Catalog: cpt-city и нажмите кнопку OK. 
e. На панели Cpt-city Color Ramp выберите вкладку Selections by theme (Тематические наборы), перейдите в раздел 

Topography (Топография) и выберите одну из доступных цветовых шкал. Нажмите кнопку OK.  

f. Вернитесь к меню Symbology (Условные обозначения), и в разделе Interpolation (Интерполяция) выберите 

пункт Discrete (Дискретная). 
g. Перейдите в раздел Min / Max Value Settings (Параметры минимального и максимального значений) и задайте 

значение 0 m для синего цвета, обозначающего уровень моря.  
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h. В разделе Color rendering (Рендеринг цвета), перейдите в меню Blending Mode (Режим смешивания) и выберите 

вариант Multiply (Умножение). 
i. Перейдите в меню слева и выберите пункт Transparency (Прозрачность), затем задайте параметру Global Opacity 

(Глобальная прозрачность) значение 80%. Нажмите кнопку OK и проверьте отображение результатов с новыми 

параметрами на холсте карты. Не забывайте как можно чаще сохранять изменения, нажимая кнопку  

 

 

Теперь карта высот воспринимается гораздо легче. Следовательно, теперь мы можем определить высоту точки по цвету и 

видеть особенности рельефа благодаря модели освещения ландшафта. 
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8.3 Работа с трехмерными картами 
В QGIS 3 за трехмерную визуализацию карты отвечает встроенный инструмент, в то время как в предыдущих версиях для 

этого использовался внешний плагин Qgis2threejs. Трехмерные карты — это хороший способ отображения различной 

информации о ландшафте. 

Перед работой в трехмерном режиме нам нужно подготовить холст карты. 

a. Загрузите файл 8_Raster/layers/roads.shy и поместите его над растровыми слоями на панели Layers. 

Мы настроим новое оформление для этого линейного слоя, чтобы он был легко различим на карте. 

b. Откройте окно Layer Properties (Свойства слоя) для слоя roads.shp и перейдите в раздел Symbology (Условные 
обозначения). 

c. Выберите вариант Single symbol (Одно обозначение), поскольку нам нужно отображать все дороги в одном стиле. 

Для отображения дорог мы воспользуемся линиями светло-серого цвета с темно-серыми контурами. Этот эффект мы 

создадим наложением светло-серой линии на темно-серую. Затем мы зададим разную ширину для каждой из линий для 

создания эффекта границы. 

d. Нажмите кнопку , чтобы добавить новый слой на панели условных обозначений.  
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e. Выберите верхнюю линию, в параметре Color (Цвет) задайте темно-серый цвет, и укажите значение 0,4 мм для 
параметра Stroke width (Ширина контура). 

f. Для нижней линии в параметре Color задайте темно-серый цвет, и укажите значение 0,5 мм для параметра Stroke 
width. 

 
 

Теперь все слои карты хорошо читаются в двухмерном режиме, и можно приступать к работе над трехмерным 

представлением. 

a. В верхнем меню выберите пункт View > New 3D Map View (Вид > Новый трехмерный вид). На экране появится 

сообщение о том, что 3D-вид в непроекционной системе координат (CRS, которая используется в QGIS по 

умолчанию) не поддерживается. 

b. Чтобы изменить CRS, перейдите в меню Project > Properties (Проект > Свойства) и выберите пункт CRS. Это меню 

также можно вызвать щелчком по значку  в правом нижнем углу экрана. 

c. В меню CRS выберите пункт projected CRS (Проекционная CRS). В данном примере мы используем систему EPSG: 

3857. Выберите один из вариантов и нажмите кнопку OK. 

d. Снова выберите пункт View > New 3D Map View. На экране появится новое окно 3D Map. 

e. Нажмите кнопку , чтобы открыть панель 3D Configuration (Конфигурация трехмерного представления).  

f. В разделе Elevation (Карта высот), выберите одну из карт DEM, загруженных в проект. Эта карта будет служить 

источником данных для отрисовки рельефа в окне трехмерного вида. 

g. В разделе Tile resolution (Разрешение заголовка) увеличьте значение до 50 px, поскольку отображаемый регион 

относительно невелик. 

h. Для параметра Map tile resolution (Разрешение заголовка карты) укажите значение 200 px (для улучшения 

качества рендеринга) и нажмите кнопку OK. Если визуализация 3D-представления занимает слишком много 

времени, то мы рекомендуем восстановить значения по умолчанию. 

i. Навигация по окну 3D-вида осуществляется следующим образом: 

- Перемещение курсора при зажатой левой кнопки мыши — перемещение камеры вверх/вниз или влево/вправо. 

- Перемещение курсора при зажатой ЛКМ и клавише Shift — поворот камеры. 

- Вращение колесика мыши — масштабирование.  
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При необходимости в реалистичном ландшафта вы можете наложить спутниковое изображение на карту высот. 
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8.4 Назначьте данные карты высот слою точек. 
В данном упражнении рассматривается классификация расположения домохозяйств по их высоте над уровнем моря. Это 

позволит оценить подверженность домохозяйств риску ущерба от природных катаклизмов, связанных с подъемом уровня 

моря (цунами, шторма и циклоны). Мы получим информацию о высоте из карты высот и добавим ее в новое поле таблицы 

атрибутов файла точек. 

a. Загрузите слой 8_Raster/layers/HHLoc_4326.shp на холст карты. 

b. В верхнем меню выберите пункт Plugins > Manage and Install Plugins (Плагины > Управление и установка 
плагинов) и убедитесь, что инструмент Point Sampling Tool установлен. Если его нет в списке, то установите его. 

c. После установки перейдите в меню Plugins > Analyses > Manage and Install Plugins (Плагины > Анализ > 

Управление и установка плагинов) или нажмите кнопку , чтобы открыть плагин. На экране появится панель 

Point Sampling Tool. 

d. В выпадающем меню Layer containing sampling points (Слой с точками выборки) выберите слой HHLoc_4326 

e. В разделе Layers with field/bands to get values from (Слои с полями или полосами для получения значений) 
выберите слой HHLoc_4326 для сохранения полей слоя точек и PRI_AST_DEM_comp, который содержит информацию 

о высотах (щелчком левой кнопки мыши при нажатой клавише Ctrl можно выбрать несколько слоев). 

Чтобы слои появились в меню плагина, они должны быть включены как видимые на панели Layers. 

f. В поле Output point vector layer (Выходной векторный слой с точками) выберите расположение и имя для 

результирующего слоя (например, HHLoc_Elev_4326.shp). Нажмите кнопку OK, чтобы запустить процесс. 
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g. Слой с точками, содержащий информацию о высоте, будет автоматически добавлен на холст карты. Откройте панель 
Layer Properties (Свойства слоя) и перейдите в раздел Symbology (Условные обозначения). 

h. В верхнем выпадающем меню выберите пункт Graduated (С градуировкой). 

i. В поле Column (Столбец) выберите поле с данными высот. 

j. В разделе Color ramp (Цветовая шкала) выберите подходящую шкалу, которая будет обозначать степень риска. В 

данном примере мы выбрали шкалу RdYlGn, расположенную в подменю All Color Ramps (Все цветовые шкалы). 

 

 
 

k. Нажмите кнопку Classify (Классификация), выберите режим для классификации (Mode) и количество классов 

(Classes), а затем задайте пороговые значения и метки для различных диапазонов. 

В результате получится облако точек, отображенных на карте согласно степени риска, определяемой высотой 

расположения точек. 
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9 УПРАВЛЕНИЕ И ХРАНЕНИЕ 
ДАННЫХ: БАЗА 
ПРОСТРАНСТВЕННЫХ ДАННЫХ - 
GEOPACKAGE 

 
   

 

В этой главе рассматривается хранение данных и 
управление различными проектами и наборами 
данных на основе двух различных подходов. 
Первый основан на использовании проектов и 
папок, а второй опирается на использование 
пространственных баз данных. 

 

   

 
 

9.1 Хранение данных и управление на основе 
проектов и папок 
 
 

Этот метод проще для начинающих пользователей ГИС, поскольку он хранит данные в структуре папок 

и подпапок. Как правило, этот метод подходит для небольших проектов. В больших и сложных проектах 

(с большим числом наборов данных из разных источников, с разными форматами и уровнями 

обработки) этого подхода может быть недостаточно. 

При использовании файловой системы важно определить критерии распределения проектных данных 

по папкам. На этот счет есть много разных подходов, и единственно правильного ответа здесь нет. 

Например, можно группировать данные по типам (векторные, растровые, табличные), по проектам 

(перепись, учет, год) или по темам (расположение домохозяйств, границы, реки, сооружения). 

К руководству прилагается гипотетический пример для Республики Малави — он хранится в папке с 

учебными материалами. 

a. Откройте проект 9_data_management/MWIProject.qgz 

b. С помощью браузера QGIS или стандартного файлового менеджера в вашей операционной системе 

откройте папку 9_data_management и изучите распределение данных по различным папкам и 

подпапкам. 
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Обратите внимание, что файл проекта расположен в одном каталоге с папкой layers. В папке layers находятся подпапки, 

где данные распределены по типам: raster, shapefile. Способ организации данных зависит от предпочтений 

пользователя, природы проекта и т.д. 
 

 
 
Опора на папки может сильно усложнить обмен проектом с пользователями, если при этом нужно сохранить настройки 

рабочего места, включая условные обозначения и метки. Если пользователь не знаком с ГИС, то процесс обмена быстро 

становится сложным и неуправляемым. 

Плагины QConsolidate и QPackage, доступные в QGIS, позволяют упаковывать слои и проекты для обмена проектами 

и папками без зависимости от структуры хранения данных. 

Для установки этих плагинов выполните следующие действия: 

a. В верхнем меню выберите пункт Plugins > Manage and Install Plugins... (Плагины > Установка и 
управление плагинами...) и в появившемся окне выберите пункт All (Все) на левой панели. 

b. Перейдите в раздел Settings (Настройки) и включите параметр Show also experimental (Показывать 
экспериментальные плагины). 

c. В поле поиска введите текст Qpackage. Выберите плагин Qpackage и нажмите кнопку Install plugin 
(Установить плагин). 

d. В поле поиска введите текст Qconsolidate3, выберите плагин QConsolidate3 и нажмите кнопку Install plugin 
(Установить плагин). 
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Поскольку оба плагина работают аналогичным образом, нам достаточно освоить только один. Мы воспользуемся плагином 
QConsolidate3, поскольку он более стабилен в среде QGIS 3. 

a. Откройте проект CookProject.qgz. Обратите внимание, что все слои имеют собственное оформление и метки. 

Также в проекте присутствует фоновое изображение. 
Из-за пока еще нерешенной ошибки проект нужно сохранить в формате .qgs. 

b. В верхнем меню выберите пункт Project > Save as (Проект > Сохранить как) или нажмите кнопку  

c. В окне Save Project As в выпадающем меню Save as type (Тип сохраняемого файла) выберите вариант 
QGIS files (*.qgs ). 

После сохранения файла в формате .qgs мы воспользуемся плагином для упаковки и публикации проекта со всеми слоями. 
d. В верхнем меню выберите пункт Plugins > QConsolidate3 (Плагины > QConsolidate3). 

e. В разделе Project name (Название проекта) можно изменить имя публикуемого проекта при необходимости. 

f. В поле Output directory (Папка для сохранения), выберите новое место для сохранения пакета. 

g. В выпадающем меню под полем Output directory выберите вариант SHP. Обратите внимание на параметр, 

позволяющий преобразовать все слои в формат GeoPackage; этот формат будет рассмотрен в следующем разделе. 

h. Параметр Consolidate in a Zip file (Объединить в файле ZIP) позволяет сохранить проект и слои в zip-архиве. 

В данном примере этот параметр мы использовать не будем. 

i. Нажмите кнопку OK. 
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j. Плагин сохранит проект по указанному адресу и создаст папку Layers со всеми слоями проекта. Это означает, что 

структура, которую вы использовали в проекте, будет упрощена плагином.  
 

 
 
 
QPackage работает аналогичным образом, но у него есть несколько отличий по сравнению с QConsolidate3. 

• Плагин QPackage позволяет выбрать слои для упаковки. 

• В настройках плагина QPackage можно выбрать целевую CRS для упакованного проекта. 

• QPackage сохраняет слои и проект в одном файле. 

• При упаковке растровых файлов плагином QPackage возникают проблемы (эта ошибка на момент составления 

руководства в феврале 2020 года все еще не устранена). 

• При упаковке проектов QPackage сохраняет текущую сессию проекта в новом месте. Если работу над исходным 

проектом планируется продолжить, то его следует сохранить, а затем открыть заново. 
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9.2 Управление и хранение данных с помощью 
пространственных баз данных (GeoPackage) 

Как правило, в данном руководстве мы использовали файлы формата ESRI shapefile (.shp) для векторных слоев. Мы 

приняли это решение, чтобы руководство было доступно начинающим и неопытным пользователям GIS. Поскольку 

shapefile — самый распространенный формат в средах ESRI и QGIS, пользователи наверняка с ним знакомы. 

Тем не менее, формат .shp не является лучшим выбором для работы с векторными слоями. В этой главе мы рассмотрим 

альтернативные форматы, существенно превосходящие по возможностям формат shapefile. 

9.2.1 Формат GeoPackage 
«GeoPackage — это открытый, стандартизированный, платформонезависимый, переносимый, автономный и компактный 

формат для переноса географических пространственных данных».3 

Более доступное описание формата GeoPackage можно найти в документации QGIS: «Открытый формат GeoPackage — 

это контейнер для хранения данных (слоев) ГИС в едином файле».4 

Основные преимущества этого формата при управлении векторными, а в некоторых случаях и растровыми данными, 

заключаются в следующем: 

Это формат с ОТКРЫТЫМ исходным кодом. 

QGIS по умолчанию использует формат GeoPackage, несмотря на поддержку shapefile и других форматов. 

GeoPackage может хранить несколько слоев с различной геометрией (точки, линии, полигоны) и различными системами 

координат (CRS) в ОДНОМ ФАЙЛЕ. При работе с shapefile для хранения одного слоя требуется создать не менее трех 

файлов (см. главу 3.1). 

GeoPackage совместим с другими ГИС и языками программирования (например, ESRI, Python, QGIS, R, GDAL). 

Процесс работы с файлами GeoPackage (редактирование, выбор, таблица атрибутов, условные обозначения, и т. д.) 

НИЧЕМ не отличается от процесса работы с shapefile. 

  

 
3 Официальный сайт GeoPackage: https://www.geopackage.org/ 

4 Документация QGIS 3.4: https://docs.qgis.org/3.4/en/docs/training_manual/basic_map/vector_data.html?highlight=geopackage 
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В следующем упражнении будет рассмотрен рабочий процесс группировки нескольких файлов shapefile (точка, линия и 

полигон), растровых слоев и стилей их оформления в едином файле GeoPackage. 
a. Откройте файл 9_data_management/MWIGeopackage.qgz 

В этом проекте содержится восемь векторных слоев в формате shapefile, и один растровый слой. Каждый слой уже имеет 

заранее настроенные условные обозначения, настройки которых хранятся в файле проекта. Мы сгруппируем эти файлы 

shapefile с помощью инструментов панели Layers (Слои). Это необходимо, чтобы не спутать уже присутствующие слои 

shapefile с файлами, которые позже будут добавлены и сохранены в формате GeoPackage. 

b. В верхней части панели Layersнажмите кнопку  для создания новой группы слоев. Дайте группе название 

Shapefile и перетащите все имеющиеся слои в эту группу. 
Далее, мы создадим файл GeoPackage. Для этого есть три способа: 

1. В верхнем меню выберите пункт Layer > Create Layer > New GeoPackage Layer... (Слой > Создать слой 
> Новый слой GeoPackage...) 

2. На панели Browser (Обзор) щелкните правой кнопкой мыши по кнопке  и выберите пункт 

Create Database (Создать базу данных). 

3. На панели меню слева нажмите кнопку . 

Во всех трех случаях на экране появится меню New GeoPackage Layer (Новый слой GeoPackage). 
c. В разделе Database (База данных) укажите расположение новой базы данных и ее имя (например, 

9_data_management/database/MWI.gpkg). 
d. В разделе Table name (Название таблицы) оставьте текст по умолчанию. 
e. В разделе Geometry Type (Тип геометрии) выберите вариант No Geometry (Без геометрии). 

Новому файлу GeoPackage необходим как минимум один элемент для хранения данных. Этот элемент позже будет удален 

из базы данных. 

f. Нажмите кнопку Ok. На панели Browser (Обзор) щелкните правой кнопкой мыши по кнопке , 

выберите пункт New Connection (Новое подключение) и откройте файл MWI.gpkg из места его расположения. 

g. На панели Browser (Обзор) файл MWI.gpkg будет отображаться в составе . После внесения 

изменений мы рекомендуем нажать кнопку для обновления папок. 

Файл GeoPackage создан. Все векторные и растровые слои будут упакованы в этот файл. Это можно выполнить двумя 

основными способами: 
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1. Панель Browser 
h. Перетащите слой MWI_HealthFacilities_4326 из панели Layers в папку MWI. gpkg, расположенную на панели 

Browser (Обзор). 

i. На экране появится приведенное ниже окно, а в древе файлов GeoPackage появится файл MWI_ 
HealthFacilities_4326. 

 

 

2. DB Manager (Менеджер баз данных) 
Инструмент DB Manager — это один из базовых плагинов QGIS. Он является основным инструментом интеграции и 

управления форматов пространственных баз данных, поддерживаемых (PostGIS, SpatiaLite, GeoPackage, Oracle Spatial, 

Virtual layers) в одном интерфейсе. 
a. В верхнем меню выберите пункт Database > DB Manager (База данных > Менеджер баз данных). 

b. В меню DB Manager, в окне Providers (Поставщики) нажмите кнопку  для отображения 

доступных подключений. Если файл MWI.gpkg недоступен, то щелкните правой кнопкой мыши по кнопке 

, затем выберите пункт New Connection (Новое подключение) и откройте файл 

GeoPackage из его расположения. 
c. Дважды щелкните по файлу MWI.gpkg для отображения элементов, уже добавленных в базу данных. 
d. Нажмите кнопку Import Layer/File (Импортировать слой / файл). На экране появится панель Import vector 

layer (Импорт векторного слоя). 
e. В разделе Input (Входной файл) выберите файл MWI_Roads_4326 
f. В разделе table (Таблица) выберите таблицу с тем же слоем, что и в разделе Input; в данном случае это 

MWI_Roads_4326 
g. Включите параметр Primary key (Первичный ключ) и нажмите кнопку OK. 
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Добавьте остальные векторные слои в файл MWI.gpkg. Попробуйте оба метода, чтобы лучше освоить их. При этом 

следует помнить, что растровые слои с помощью DB Manager добавить нельзя, поскольку в настоящее время плагин их не 

поддерживает. Следовательно, добавлять в базу данных эти слои можно только перетаскиванием. После выполнения всех 

операций дерево файлов GeoPackage должно выглядеть аналогично рисунку ниже. 
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h. Теперь можно удалить пустую таблицу M, которую мы создали ранее. На панели Browser (Обзор) щелкните правой 

кнопкой мыши по таблице M и выберите пункт Delete Layer 'M' (Удалить слой M). 
Слои упакованы в пакет GeoPackage, и теперь их можно добавить на холст карты. 

a. На панели Browser в ветке GeoPackage выберите MWI.gpkg и добавьте каждый из его слоев на холст двойным 

щелчком или перетаскиванием на холст. Убедитесь, что при добавлении слоев из файла Geopackage они 

располагаются вне группы слоев, созданной в начале этого раздела. 
Далее мы скопируем стили из слоев shapefile и сохраним их в виде таблицы в файле GeoPackage. Это позволяет сохранить 

оформление слоев даже при их открытии в другом проекте QGIS. 
b. Щелкните правой кнопкой мыши по слою MWI_HealthFacilities_4326 (он находится вне группы shapefile) и 

выберите пункт Styles > Copy Style > All Style Categories (Стили > Копировать стиль > Все категории 
стилей). 

c. Щелкните правой кнопкой мыши по слою dWI_HealthFacilities_4326 в пакете GeoPackage и выберите пункт Styles 
> Paste Style > All Style Categories (Стили > Вставить стиль > Все категории стилей). Слой получит 

новые настройки обозначений и меток. 
d. Перейдите на панель Layer Properties (Свойства слоя). В меню Symbology (Условные обозначения) 

нажмите кнопку Style (Стиль) (в левом нижнем углу), выберите пункт Save Style (Сохранить стиль), и на экране 

появится панель Save Layer Style (Сохранить стиль слоя). 
e. В выпадающем меню Save style (Сохранить стиль) выберите пункт In database (GeoPackage) (В базе 

данных (GeoPackage). 
f. В поле Style name (Имя стиля) укажите имя сохраняемого стиля (например, HealthFacilities), добавьте описание 

при необходимости, и нажмите кнопку OK. 
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Выполните те же действия для копирования стилей векторных слоев в их эквиваленты в пакете GeoPackage и сохраните 

стили в базе данных. Эти действия нужно выполнить для всех стилей, кроме растрового (причины этого будут объяснены в 

конце главы). 

g. Откройте инструмент DB Manager, выберите пакет GeoPackage и разверните базу данных MWI.gpkg. Вы увидите 

новую таблицу под названием layer_styles, в которой теперь хранятся стили для векторных слоев базы данных. 

Проверить содержимое таблицы можно переходом на вкладку Table (Таблица) справа от меню. 
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h. Откройте новую сессию в QGIS и попробуйте загрузить слои, добавленные в базу данных MWI.gpkg. Теперь слои 

будут отображаться с настройками обозначений, хранящимися в базе данных GeoPackage. 
GeoPackage поддерживает хранение растровых слоев, но не их стилей. Это значит, что хранение стилей таких слоев будет 

осуществляться так же, как раньше — либо сохранением стиля в проекте, либо сохранением его в файле .sld или .qml, 

который можно загрузить после открытия растрового слоя. 
Как уже упоминалось в начале главы, при работе с векторными слоями, хранящимися в базе данных GeoPackage, рабочий 

процесс в среде QGIS ничем не отличается от работы с файлами shapefile. Для работы с GeoPackage никаких новых 

навыков не требуется — нужно только понимать основные принципы хранения информации в этом формате. 
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10 МЕТАДАННЫЕ 
 

10.1 Заполнение метаданных (стандарты и 
совместимость) 
Метаданные — это сведения о данных. В метаданных записываются и документируются важные сведения о наборе 

данных, включая сведения об авторе, описание, аннотации, ключевые слова, сведения об обновлении, дата создания / 

обновления и другие. 
Формат метаданных в QGIS 3.x отличается от формата QGIS 2.x. На момент составления руководства (07/2019) редактор 

метаданных QGIS не поддерживает ни стандарт ISO 19115, ни стандарт ISO 19139; тем не менее, их структура имеет 

похожую организацию. 
В данном примере мы составим файл метаданных для слоя schools- unicef-2004 с информацией о расположении школ, 

выступая на правах авторов и владельцев этого набора данных. Набор данных получен из системы 

https://data.humdata.org/. Файл To add into metadata.txt находится в одной папке вместе со слоем и содержит информацию, 

которую можно добавить в метаданные слоя. 
a. Загрузите файл 10_metadata/layers/schools-unicef-2004.shp, откройте панель Layer Properties (Свойства 

слоя) и перейдите в раздел Metadata (Метаданные). 
Меню метаданных помогает оптимизировать процесс ввода данных и позволяет создать сводку по метаданным для слоя. 

b. Identification (Идентификация) — это основные сведения о наборе данных (родительский идентификатор, 

идентификатор, название, тип, язык, аннотация). 
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c. Categories (Категории). Редактор метаданных включает категории ISO. Выберите категорию из панели ISO 

categories (Категории ISO) и нажмите кнопку  для ее добавления на панель Chosen categories 

(Выбранные категории). Вы можете добавить собственные категории, нажав кнопку . 

 
 
 

d. Ключевые слова помогают осуществлять процессы получения данных в соответствии со стандартами и 

глоссариями. В данном случае мы проверили терминологию с помощью сайта GEMET при добавлении нового 

понятия и связанных с ним ключевых слов. 
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e. В разделе Access (Доступ) мы добавим информацию о лицензиях, правах, сборах и других ограничениях. По 

следующей ссылке можно найти информацию и рекомендации по заполнению этого раздела: 
https://theodi.org/article/publishers-guide-to-open-data-licensing/ 

f. Вкладка Extent (Область) хранит информацию о пространстве (CRS, область карты, высоты) и времени. Нажмите 

кнопку Set CRS from layer (Указать CRS слоя), и система добавит информацию согласно настроенным свойствам 

слоя. Сведения об области можно заполнить вручную или выбором одного из следующих пунктов: Current Layer 
Extent (Область текущего слоя), Calculate from Layer (Вычислить по слою) или Map Canvas Extent (Область 
холста карты). 
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g. В разделе Contact (Контакты) укажите сведения о владельцах и других лицах или организациях, ответственных за 

создание набора данных. 

 

 
 
 

h. На вкладке Links (Ссылки) можно указать ссылки на дополнительные ресурсы и информацию, включая базы 

данных в интернете, каталоги или документацию. 

 
 

i. Раздел History (История изменений) содержит информацию об исправлениях, изменениях и версиях набора 

данных. 
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j. В разделе Validation происходит проверка на соответствие минимальным требованиям к метаданным. Метаданные 

обязательно должны содержать идентификатор, язык, тип, заголовок, аннотацию, ссылки, контакты, сведения о 

лицензии, CRS и области. 

 

 
 
 

k. Перейдите на вкладку Information (Информация) и вы увидите, что информация, которую вы добавили на вкладке 
Metadata, появилась здесь автоматически. 
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По умолчанию метаданные хранятся вместе с файлом проекта. Однако это не позволяет получить к ним доступ при 

открытии данного слоя в другом проекте. Чтобы решить эту проблему, нужно выполнить следующие действия: 
l. В разделе Metadata нажмите кнопку Metadata, расположенную в левом нижнем углу, и выберите в меню пункт 

Save Metadata (Сохранить метаданные). 
m. Введите то же имя файла, что и у слоя (schools-unicef-2004.qmd). Расширение .qmd будет добавлено 

автоматически. Важно сохранить файл .qmd в одной папке с другими файлами слоя (.shp, .shx, .dbf, и т. д.). Это 

позволит программе автоматически считывать метаданные слоя, как, например, в случае с файлами таблицы 

атрибутов или информации о проекции. 
При использовании другого формата слоя (GeoPackage, KML) или при хранении метаданных в файле под другим именем 

их можно добавить в метаданные слоя вручную. 
n. В разделе Metadata, нажмите кнопку Metadata в левом нижнем углу и выберите пункт Load Metadata. Выберите 

файл .qmd с метаданными для слоя и нажмите кнопку OK. Метаданные отобразятся в разделе Information. 
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